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x Axcient DirectRestore

1 Product overview

Axcient DirectRestore (ADR) is a granular data extraction software for offine SQL databases and Microsoft
Exchange Server mailbox stores and Outlook files. The utility provides direct access to unmounted database
tables and mail store contents, displaying file structure and its contents with selective export functionality.
With a search query tool, users are able to export specific queries rather than large tables or files.
For SQL databases, recovered items can be saved as SQL scripts or exported directly to a live SQL server.
For Microsoft Exchange servers, files can be saved as Personal Storage File (.pst) files, to be opened with
Microsoft Outlook or other compatible email clients, or exported directly into live Exchange Server mailboxes.
The utility makes no changes to the store, presening it in original unmodified state.
Main features of Axcient DirectRestore:
SQL Database

@ Recowers entire tables, objects and object groups

® Recowers data obtained by specific search queries

® Recowers keys, scripts, functions, triggers and procedures

@ Recowvers default settings, user types and views

(& Saves single or multiple points of data as SQL scripts or exports to live SQL database
Microsoft Exchange Server

@ Recowvers mailboxes, folders, messages and file attachments

@ Recowvers contents of Public Folder mailboxes

@ Recowvers email addresses from Active Directory storage

@ Recowers notes, contacts, tasks and appointments

@ Recowers creation dates for all objects

@ Saves selected items to PST files or exports to live Exchange Server mailbox(es)

1.1 Supported Exchange database versions

Axcient DirectRestore supports the following mail store versions:

2019 CU9,2019 CU8, 2019 CU7, 2019 CU6, 2019 CU5, 2019 CU4, 2019 CU3, 2019 CU2, 2019 CU1, 2019,
2016 CU20, 2016 CU19, 2016 CU18, 2016 CU17, 2016 CU16, 2016 CU15, 2016 CU14, 2016 CU13, 2016
CU12, 2016 CU11, 22016 CU10, 016 CU9, 2016 CUS8, 2016 CU7, 2016 CU6, 2016 CU5, 2016 CU4, 2016 CU3,
2016 CU2, 2016 CU1, 2016 RTM, 2013 CU21, 2013 CU20, 2013 CU19, 2013 CU18, 2013 CU17, 2013 CU16,
2013 CU15, 2013 CU14, 2013 CU13, 2013 CU12, 2013 CU11, 2013 CU10, 2013 CU9, 2013 CU8, 2013 CU7,
2013 CU6, 2013 CU5, 2013 SP1, 2013 RTM, 2010 SP3, 2010 SP2, 2010 SP1, 2010 RTM, 2007 SP3, 2007
SP2, 2007 SP1, 2007 RTM, 2003.

Note

Exchange Server 2003 stores data in two files: an .edb file and an .stm file, that's why they should be kept
together and should have a common name with different extensions (that is, .edb and .stm). For further
information, please visit Microsoft TechNet - http://technet.microsoft.com/en-

us/library/bb124808(v=exchg.65).aspx.

1.2 Supported Outlook versions
Axcient DirectRestore supports the following versions of PST/OST files:
2016, 2013, 2010, 2007, 2003, XP, 2000, 98 and 97

Note
OST file of 2013, 2016 version is not supported.
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1.3 Supported SQL Server database versions

Axcient DirectRestore supports the following versions of MDF/BAK files (including Express edition):
2019, 2017, 2016, 2014, 2012, 2008R2, 2008 and 2005

1.4 System requirements

Basic system requirements:

e Operating systems: Windows 10, Windows 8.1, Windows 8, Windows 7, Vista, 2019 Server, 2016 Senwer,

2012 Server R2, 2012 Server, 2008 Server, 2003 Server or XP

o RAM: 1024MB, depends on store size and OS version

¢ Hard Disk: minimum 50MB of free space required for installation

o Display: 800 x 600 or higher resolution, 256 colors
Additionally, Axcient DirectRestore may require free space on disk 1.5x the size of mail store being
processed. For example, for 300MB store, 450MB free space should be available.

1.4.1 Live Exchange Server export requirements

Exchange Server

Exchange Server 2019, 2016, 2013, 2010 or 2007

Exchange Web Senices enabled on Exchange Server

Network

Port 443 open on the network. The EWS messages are transported via SOAP-based API, which is essentially
sending XML data using https protocol.

Restore client

ADR installed. Access to Exchange server(s) over network.

1.4.2 Live SQL Server export requirements

SQL Server

SQL Server 2017, 2016, 2014, 2012, 2008R2, 2008 or 2005

SQL Server Browser running on SQL Senrver

Network

To establish connection to live SQL Server, remote network access must be allowed on the server and TCP/IP
protocol must be enabled in SQL Server Configuration Manager. For detailed instructions on how to do it, visit
http://blogs.msdn.com/b/walzenbach/archive/2010/04/14/how-to-enable-remote-connections-in-sqgl-server-
2008.aspx

Restore client

ADR installed. Access to SQL Server(s) over network.

1.5 Limitations

Current version of the product has the following limitations:
¢ While processing dirty shutdown databases storages may be restored not to the topical condition.
e Messages in the Outbox folder are not restored if they haven't been synchronized with the server.
e Simultaneous recoweries are not supported.
e Simultaneous running of more than one instance of the product is not supported.
e Encrypted emails are not restored.
¢ Messages with size over 64MB are not supported.
¢ Windows 2000, 98, ME and 95 are not supported.
e Recovery of delivery receipts and non delivery reports is not supported.
¢ Tool doesn't support usage in "Run as different user" mode.
e OST files, created in Outlook 2013, 2016 are not supported.
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Password-protected PST files are not restored in command-line interface.

Command-line interface is not supported for MDF and BAK files.

Compressed SQL Server 2014, 2016, 2017 BAK files are not currently supported.

System MDF and BAK files are not currently supported.

Encrypted SQL databases are not currently supported.

Calculated fields and fields of type [sql_variant] in indexes cannot be used in SQL database search.
Sparse columns in SQL database are not supported.

Filestream data type and Filetables in SQL databases are not currently supported.

Searching by 'real' data type may return not full results.

Approved status of Calendar Events is not supported.

Links to the Exchange Global Address List are not supported.

Exchange Server Databases: Preview items with 4-byte Unicode characters may be not full in product
started on Win7 and WS2008 OS. It is not affect on quality of restoring into PST or into live server.
Exchange Server Databases: Search input field may work incorrectly with 4-byte Unicode characters. It
does not affect on results of search.

MS SQL Server: schemas with name containing a dot (".") - for example, "[custom.schema]" - can not
be restored.

MS SQL Server 2017: restore of graph tables is not supported.

MS SQL Sener: for "sql_variant" datatype basetypes are not restored correctly (values are restored with
"nvarchar" basetype).

MS SQL Server: secondary data files are not currently supported.

MS SQL Server: decimal values close to maximal/minimal can not be restored to live SQL server through
injection.

Injection limitations for Exchange Server

To restore a mailbox, an empty mailbox must be created in advance using the standard Exchange
Server administration tools or can be created from ADR. In existing mailboxes folders and individual
messages can be created without any additional administrative actions.

It is possible to rename/delete folders in the attached mailbox only within one program session.
Injection will not be supported for Exchange Server 2003 and earlier versions. These versions do not
support EWS.

Archived mailboxes (and items from such mailboxes) are not exported to live Exchange Server.
Photos of contacts are not exported to original live mailbox in Exchange Server 2007.

Emails with embedded images and other OLE objects are displayed with an attachments icon after
exporting into live Exchange Senwer.

Creation time and modified time are not restored.

Exporting data into live public folder is not supported.

Exporting data from PST/OST files into original mailbox is impossible.

Contact groups and meeting requests cannot be exported into live Exchange Server 2007 instances.
Use export through PST for these item types.

Missing sent date is exported as current date/time into live Exchange Server.

It is impossible to use the connection to the archive mailboxes, as they can not be found in the Active
Directory.

For IPM.Task class items existing "Date Completed" value is exported into live Exchange Server as
current date/time.

For IPM.Task class items "Update List" field is not restored after injection.

Limitations for search in attachments content (available for EDB/PST/OST files)
Search in attachments does not work for:

Text contained in embedded OLE objects, WordArt and smart objects, charts etc. Documents metadata
(author, comments, tags etc.).

Marker symbols in lists (numbered or bulleted).

Text in header/footer.
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e XLS/XLSX number values, formulas, cell comments.
e PPT: tables content.

Mailbox creation limitations:
¢ Creating new mailbox is not supported on Exchange Server 2007 and earlier versions.
e Prior to creating new mailbox on Exchange Server it must be properly configured.
¢ The machine with Exchange Server must have Exchange PowerShell installed.
e Exchange Server connection must be performed using credentials of the user who has permission to
create mailboxes (e.g. Administrator).

Tip

Note that the utility is best used for granular item extraction. The user interface of the program is designed
for ease of locating, selecting and exporting specific messages, folders or mailboxes. Entire databases can
be exported as well, but the restore time will significantly increase over a slow connection. For bulk
operations that inwolve exporting more than one mailbox it is typically better to work with a local copy of the
database.

1.6 Boundaries for optimal recovery and search

Usage of Axcient DirectRestore is optimal for files that do not exceed:
EDB:

e EDB size: 2TB

¢ Mailbox size: 100GB
Number of messages in the EDB file: 2,000,000
Number of mailboxes in the EDB file: 2,000

o Number of messages in one mailbox: 100,000
PST/OST:

o PST/OST size: 100GB

o Number of messages in the PST/OST file: 200,000

o Number of folders in the PST/OST file: 1,000

e Number of messages in one folder: 100,000
MDF/BAK:

o MDF/BAK size: 1TB

e Number of tables in the MDF/BAK file: 1,000

e Number of rows in one table: 10,000,000

1.7 Customer support
For customer support, please contact Axcient using one of the methods listed below.

Online: http://www.axcient.com/support/contact/
Email: support@axcient.com
Tip

When contacting customer support with a technical issue, please have ready the program's log files and
the store you are having difficulty with.

To get log files, click File menu and choose Open log folder. Zip the contents of the folder and attach the
resulting archive to your support request.

If the log archive and/or mail store exceeds 10MB, it may be impossible to send them as an email
attachment. In that case, upload instructions will be provided to you upon request.

Version 21.2.2 Page 7
Copyright ©2021 Axcient, Inc. All Rights Reserved.



x Axcient DirectRestore

2 Installation

This chapter describes the steps required to install Axcient DirectRestore.
Depending on your preferences, it is possible to install the product in default or advanced mode.
Default mode
Default mode provides simple setup that requires just a few mouse clicks to complete. For the sake of
simplicity, it does not offer any customization capabilities and uses the following default settings:

¢ Axcient DirectRestore will be installed in a per-user folder and be available just for your user account.

You do not need local administrator privileges in this case.

e The default installation location is "C:\Program Files\Axcient\DirectRestore\"

¢ A shortcut for this program will be created on the desktop automatically.
Step by step instructions:
1. Double-click on the setup file to start the installation process.
2. The Software License Agreement appears. Read it and accept the terms in the License Agreement.
3. Click Install to start setup .

il Axcient DirectRestore Setup = =

A )( C ' E N T Axcient DirectRestore

Beyond Backup ™ Build 20.4.0.56249

Copyright © 2012-2017 Axcient, Inc.
. SOFTWARE LICEMSE AGREEMENT FOR AXCIEMT
DirectRestore SOFTVWARE

This Software License Agreement ("SLAY) is a legal
agreement between you (either an individual or a

single entity) and Axdent, Inc. for the Axdent

software product identified above, which indudes
computer software and may indude assocated W

[+/]I accept the terms in the License Agreement

Click Install to install the product with default options just for
you. Click Advanced to change installation options.

Print E Install —j Advanced Cancel

4. The installation will start. When finished, you will have an option to launch the installed product.
Advanced mode

Advanced setup mode allows changing default installation options.

Step by step instructions:

1. Double-click on the setup file to start the installation.

2. The Software License Agreement appears. Read it and accept the terms in the License Agreement.
3. Click Advanced to change installation options described above.
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A)‘ CIENT Axcient DirectRestore

Bayvond Backup ™ Build 20,4.0,56243
ve P Copyright © 2012-2017 Axdent, Inc.

' SOFTWARE LICENSE AGREEMENT FOR AXCIEMNT
DirectRestore SOFTVARE

This Software License Agreement ("SLA") is a legal
agreement between you (either an individual or a
single entity) and Axdent, Inc, for the Axdent
software product identified above, which indudes
computer software and may indude assodated

[+]1 accept the terms in the License Agreement

Click Install to install the product with default options just for
you, Clidk Advanced to change installation options,

4. Click Next to install the product to the default folder or Change... to choose another folder. To add an icon
shortcut to the desktop for quick start of the program, check Create a shortcut for this program on the
desktop. Click Next.

Destination Folder
Click Mext to install to the default folder or dick Chanage to choose another.

Install Axdent DirectRestore to:

IC:‘IFrogram Files (x86)\Axdent},

Create a shortout for this program on the desktop,

5. Click Install to begin the installation. Click Back to change any of your installation settings. Click Cancel
to exit the setup wizard.
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6. After the installation finishes you can choose to Launch Axcient DirectRestore when setup exits to
start the program automatically by clicking the appropriate checkbox. Click the Finish button to exit the
setup wizard.

2.1 Product activation

When starting Axcient DirectRestore for the first time, you are prompted to activate the product by entering
your RMC credentials.

m—

Enter your login and password from the RMC Axdent web site,

Login Enter your RMC credertials
Password sesssssnnsnns
Forgat vour password ? Dont have an accourt?

Cancel Activate

In case problem with incorrect credentials, please use link Forgot your password?.

In case you don't have RMC account, please use License key for activation (for getting this, please contact to
support team). For it click link Don’t have an account?.

Enter the license key, and provide the names of registered user and company. Click Activate to finish the
activation.
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Enter license key Confirmation
Enter license key and registration information.
License key: |Erter the License keey, supplied after the purchase ‘
1
Name: ! Erter your name |
Company: Enter the name of the company (leave blank i the program will be uzed for personal needsj |

Tip
When getting an error message, first of all check if the license key has been entered correctly. It's best to
copy and paste the key to awoid typos.
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2.2 Updating the product

In order to update the product automatically as soon as a new version is released, use auto-update, available in
the Options menu.

Options | Help

Show mailbox mismatch warning in expert mode

Show delete folder warning in expert mode tes or folders to search

I 3
G
[SI<[<T=IS]

Show notification panel

Show progress dialog

Allow connections to live servers Database.edb Mo live servers connected.

o

E-E-E-E-E-E-E-E-E-E-]

Search within attachments Connect to a live server to enable
ge Server Database\Maibox Database.edb export of objects from source storage.
PST encoding * Mb
Incomplete messages v 3/2014
3
13

Show deleted items xchange Server 2013

Display time
Updates 4 Check for update on startup
o ﬁ Luise 22 mal + | Update automatically

- ﬁ Maria Woods Load tim

0[] Michael Check for updates

0[] =9 Personal Archive - HealthMailboxadsSae Fe5b Display time:

11| =) Personal Archive - HealthMailbaxbaa80422260  PST encoding: Unicode (Microsoft Outiook 2003, 2007, 2010 and
2013)

Show deleted tems: Both

: Incomplete messages: Hide

-9 Rudy Raid Search within attachments: Off

(-] £9 Susane Tyler

[]&9 SystemMaiboxladeSas F-25b5-4860-3 1cf-021

-] &9 Tim Goodler

£ >

(£

(£

(£

-

File info

[11/17/2016 6:43:29 AM] Database load time: 0 hour(s) 0 minute(s) 4 second(s)

Completed

If these options are enabled, user will be notified about updated version by the following dialog and update
process will start in 5 seconds:

You are running Axcient DirectRestore version 20.2.0.55467.
|pdate to version 20.3.0.55824 is available!

Release notes:

|h.|ew major features and improvements:

- Support work with Exchange Server version 2016 CUS

- Added feature to mark fields with input emors while searching in SGL Server databa:
- Added a prompt when deleting non-empty folder in expert mode

Foved bugs:
- resalved problems with export into afginal exchange mailbox
- resolved problems while working with SCL Server files

[l L 1

£

Running copy of the application will be closed when install process begins.
If you do not have administrator privileges, download and install this build at:

hitp:/“aecient .com.files/documentation/Downloads./esr-20.3.0.55824-setup-gc. msi

] Dont remind me on startup until the next update

Download and install | | Maybe later e|

In case if the point Update automatically is not checked, user should manually click the Download and
install button.
To disable this option remove the check marks Check for updates on startup and Update automatically.
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In this case you will not get any notifications, when a new version becomes available for downloading. Use
Check for updates in the Updates menu to verify if any updated version is ready to be used.

Options | Help

Show mailbox mismatch warning in expert mode

Show delete folder warning in expert mode Select mailboxes orfolders to search

Show notification panel

Show progress dialeg

Database.edb

Allow connections to live servers

Search within attachments ge Server Database\Mailbox Database.edb
Mb

3/2014

Incomplete messages * Ixchange Server 2013

Show deleted items 3

PST encoding 3

n logs not used.

Display time 3

L4 | Check for update on startup
Load time Update automatically

Display il Check for pdates )
[[]£9 Personal Archive - HealthMailboxadeSae Fe5b! PST encoding: Unicode (Microsoft Outlook 2003, 2007, 2010 and 2013)
{19 Personal Archive - HealthMaiboxbaa8042¢260 Show deleted items: Only non-deleted items
£y Richard Incomplete messages: Hide

-] 5 Robert Rise search within attachments: Off

-] &) Romeo Montague

[]&9 Rudy Raid
[[]£9 Susane Tyler
Dﬁ SystemMailbox{adeSae F-e505-4860-a1cf-021

Dﬁ Tim Goodler

< File info

Completed
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3 Opening a file
To directly open a file for browsing and export, launch Axcient DirectRestore and click file open button on the

taskbar or select File|Open from the menu. On first launch, the file open dialog will be shown automatically.
Select the store you will be working with and click Open.

| Bxchange Server Database (€] [Q’ 5 g

-~

(T Mame Date modified Type

e < Mailbox Data 8/16/20124:26 AM  Exchange Server ...
Recent places  E5¥ Wi libox Database 31373014 351 &AM Exchange Server ..

Desktop

Libraries

A

This PC

File name: | Mailbox Database W |

Files of type: |.P|.II supported formats (*edb, * pst, *.ost, *mdf, = bak) W |

Path to log files: | || Browse... |

By default, a progress window will accompany opening the selected file. The window displays overall progress
and information about the number of items and objects in the file (1). The window can be disabled by

unchecking the Show the dialog next time check box (2) or from the Options menu. The progress window
will be automatically closed in 3 seconds after database opening (3).

Show the dialog next ime 9

Current operation can be cancelled right on the progress dialog, by clicking an appropriate link.
After loading the file is complete, it will be available for browsing and export. The opened store will also become
the default store and will be automatically reopened next time you launch the utility.
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Opened database can be reloaded with database log files. Go to the File menu and select Reload database
using transaction logs.

File | Options Help

Open file...

Recent Select mailboxes orfolders to search

Close file

eloa € using transaction logs

ailbox Database.edb

Search for files to open...

Export selected items into PST... Ctrl+S Exchange Server Database\Mailbox Database.edb
e: 904 Mb

: te: 3/13/2014

Cancel current operation Ctrl+N rsion: Exchange Server 2013

Open log folder

Export into original Exchange mailbox...  Ctrl+G

) ansaction logs not used.
Delete saved temp files and logs
Exit mailboxes. Select a mailbox to display folders.

ey d time: 00:00:03

-] 59 Maria Woods

159 Michael Display time: GMT

[[]£9 Personal Archive - HealthMaiboxadeSae e5b! PST encoding: Unicode (Microsoft Outlook 2003, 2007, 2010 and 2013)
{19 Personal Archive - HealthMaiboxbaa8042¢260 Show deleted items: Only non-deleted items

[]=9 Richard Incomplete messages: Hide

[ Robett Rise search within attachments: Off
-] &) Romeo Montague
159 Rudy Raid

[[]£9 Susane Tyler

Dﬁ SystemMailbox {adeSae F-25b5-4860-a 1cf-021
Dﬁ Tim Goodler

' Fileinfo |

<

Completed

Note
If you closed the progress window, it can easily be shown again by clicking on the progress bar on the
status panel.
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3.1 Finding a file

In case when the location of the file is unknown, it is recommended to scan existing drives to find the data.
Axcient DirectRestore scans local drives, both mounted and unmounted, as well as network drives and
searches for PST/OST, MDF/BAK and EDB files.

To start a new search click Search for files to open in the File menu.

File | Options  Help

Open file... Ctrl+ O

Recent Select mailboxes orfolders to search

Close file

Reload database using transaction logs

(TR e ) pilbox Database.edb

Export selected iterns into PST... Ctrl+5 Exchange Server Database\Mailbox Database.edb
e: 904 Mb

. te: 3/13/2014

Cancel current operation Ctrl+N rsion: Exchange Server 2013

Open log folder

Export into original Exchange mailbox...  Ctrl+G

ansaction logs not used.

Delete saved temp files and logs

mailboxes. Select a mailbox to display folders.
d time: 00:00:04

Exit
oo
-] 59 Maria Woods
[1£9 Michael Display time: Local
[[]£9 Personal Archive - HealthMailboxadeSae FeBb! PST encoding: Unicode (Microsoft Outlook 2003, 2007, 2010 and 2013)
[[]£9 Personal Archive - HealthMaiboxbaa80426260 Show deleted items: Only non-deleted items
(]9 Richard Incomplete messages: Hide
[] =9 Robert Riss Search within attachments: Off
[]£) Romeo Montague

Dﬁ SystemMailbox {adeSae F-25b5-4860-a 1cf-021
-] &9 Tim Goodler

< Fileinfo |

Completed

The following form appears, displaying the list of mounted disks:

File types by application:
Exchange Server (".edb)
[ = New Valume (E:) Outlook (*pst, *.ost)
SQL Server (".mdf, ~bak)

Custom match:
|Exarnp|e: *edb;” ost

Add location to search... | [ Include unmounted volumes

Found files: Fiter: | All

File Date modified Type

Open file Start search
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To use unmounted disks (NTFS and FAT32 file systems are supported) for search, check Include
unmounted volumes. All unmounted wlumes will appear in the list of disks.

File types by application:
Exchange Server (*.edb)

O —a New Volume (E3) Outlook {* pst, * ost)
[ 1= Unmourted disk 1 {Volume{16739c74-5620-11e3-824b-306=6626963})
SQL Server ("mdf, bak)

Custom match:
|Exarnp|e: *edb;” ost

Add location to search... | Include unmourted volumes

Found files: Fiter: | All

File Date created Date modified Type

Open file Start search

Note
Only NTFS and FAT32 file systems of unmounted drives are supported.

Select a location to search in.

File types by application:
Exchange Server (" edb)
=a New Volume (E:) Outlook {* pst, *.ost)

SQL Server ("mdf, *bak)

Custom match:
|Exarnp|e: ~edb;” ost

Add location to search... | [ Include unmounted volumes

Found files: Fiter: | Al

File Date created Date modffied Type

Open file

List of found files will be displayed. Double-click a file to open it.
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X

Select source: File types by application:
iy Local Disk (C3) Exchange Server (*edb)
o New Volume (E) Outlook (" pst. " ost)
SQL Server (" mdf, *bak)

Custom match:
|Examp|e: ~edb:” ost

Add location to search. .. | [] Include unmeunted volumes

Found files: . | Al

File Size Date created Date modified Type

C:\Exchange Server Database'\Mailbox Data edb 648 MB 6/22/2016 81672012 Exchange Server (" edb)
C:\Exchange Server Data...\Mailbox Database.edb 904 MB 1/24/2016 31372014 Exchange Server ("edb)
C:\AllTest Scripts'\Scrpt \AC_edb sj bak 7.02KB 5/20/2019 5/20/2019 SQL Server (*mdf, *bak)
C\All Test Scripts'Script \AC_pst 5j bak B.65 KB 5/20/2019 820/2019 SOL Server ("mdf, ~bak)
C\All Test Scripts Script \MC.5j bak 131 KB 5/20/2019 52072019 SOL Server ("mdf, = bak)
C\AllTest Scrip.. \utaCheckGLSearch_edb sibak 176 KB 5/20/2019 5/20/2019 SQL Server (*mdf, *bak)
C\AllTest Scripts'Scrpt'\AutoCheck Search sjbak  13.7 KB 5/20/2019 52072019 SQL Server ("mdf, = bak)
CAllTest Seripts'...\AutoCheck Search_edb sjbak 186 KB 5/20/2019 5/20/2019 SQL Server (*mdf, *bak)
CAllTest Scripts'S.. \AutoCheck Search_pst sjbak 170 KB 5/20/2019 5/20/2019 SQL Server (“mdf, * bak)

Open file Search complete. 150 file(s) found. | Clear list and search again | |

Note
To scan unmounted disks, the user, running the program, must have administrative rights.

4 Axcient DirectRestore. SQL Server
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4.1 Finding and browsing data

In general, Axcient DirectRestore provides two modes of processing file data: browsing the file tree and search.
Using these, it is possible to efficiently form a set of objects for subsequent export, including the necessary
ones and excluding ones to be skipped.

A newly opened database is shown in the Browse mode.

r Axcient DirectRestore = =
File  Options Help

~~

Search... 2

Browse

=[] oy AdventursWorks2012_CS_Data.mdf
B[ JE3 Programmability (4)
¢ @[ ]C@ Functions (11)

[JE3 Procedures (10}

[]E3 Rules (0}

[]E3 User Types (8]

I e 01

m-[]Eg Views (20)

Tables

71 objects. Select an object to display data.

Folder info

Completed

4.1.1 Browsing database tree

Browse mode shows database in a tree-like structure and allows browsing folders and previewing individual
objects.

This mode is best for navigating to a specific object, when it is precisely known what data needs to be
extracted.

For example, a user may ask to restore some specific table. Expand the folder Tables' in the tree and select
the table. Available rows will be listed to the right of the tree. Please note that product will not try to load all
rows in table. Instead of that rows will be loaded by portions each time you navigate to the end of list.
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File  Options Help

=

Browse

£

Search in Person Address

K

= ey AdventureWaorks2012_CS_Data mdf

v-[_]C3 Programmability (4}

- ]Cm Tables (71)

17 dbo AWBLidVersion (1)

[1=] dbo.Databaselog (1,557)

[(1=] dbo EmarLog (D)

[1=] HumanResources.Department (16)
[(1=] HumanResources.Emplayes {250)
[[]=] HumanResources.Employee Departmert
[1=] HumanResources. EmployesPayHistory
[1=] HumanResources.JobCandidate (13)
[ HumanResources.Shift (3)

M= Person Address (19.614)

[1=] Person.AddressType (5}

[[]=] Person BusinessErtity (20.777)

[1=] Person.BusinessEntityAddress (19.614)
[1=] Person.BusinessEntityContact (309)
[1=] Person.Contact Type (20)

[C1=] Persen CourtryRegion (238)

[1=] Person.EmailAddress (19.572)

[C1=] Person.Password (19.572)

[C]=] Person.Person {19,572)

[C1=] Persen.PersenPhone (19,972}

[1=] Person.PhoneNumberType (3)

[[]=] Person.StateProvince (181)

[1] Production. BillOfMaterials (2,675}
[1=] Production Culture (8)

[ Production.Document (13)

[(1] Production. llustration (5}

Address|D

1
2
3
4
5
6
-
8
Bl

10
1Al
12
13

14
15
16
17
13
13
20
21
22

AddressLine1

1570 Napa Ct.

5833 Mt. Dias Blv.
7484 Roundtree Drive
3539 Glenside Dr
1226 Shoe St.

1359 Firestone Drive
5672 Hale Dr.

6387 Scenic Avenue
8713 Yosemite Ct.
250 Race Court
1318 Lasalle Street
5415 San Gabriel Dr.
5265 La Paz

8157 W. Book

4912 La Vuelta

40 Eliis St.

6656 Anchor Drive
1873 Lion Circle
3148 Rose Street
6872 Thomwood Dr.
5747 Shirey Drive
B3E Vine Hill Way
6657 Sand Pointe Lane
80 Sunview Temace
5178 Jumping St
5725 Glaze Drive

AddressLine2

NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL

City
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Portland
Seattle
Duluth
Dallas
San Francisco

StateProvincelD

it R g g v v i e B i v v i R e e . . - R R B

w

PostalCode

58011
58011
58011
58011
58011
58011
58011
58011

SpatialLocation ™

xE6100000010C.
(xE6100000010C
(xE6100000010C
xE6100000010C
(xE6100000010C
(xE6100000010C
IxE6100000010C
(xE6100000010C
(xE6100000010C
xE6100000010C.
(xE6100000010C
(xE6100000010C
xE6100000010C
(xE6100000010C.
(xE6100000010C.
<E6100000010C
(xE6100000010C
(xE6100000010C.
<E6100000010C
(xE6100000010C
(xE6100000010C
<E6100000010C
(xE6100000010C
(xE6100000010C
<E6100000010C

xE6100000010C ¥
>

Completed

In case if SQL script of a table is necessary, just right-click on the table in the database tree and select 'Show

SQL script' in the context menu.

File  Options Help

=

Browse

= ey AdventureWaorks2012_CS_Data mdf

£

Search in Person Address

K

- ]E@ Programmabiity (4)

=[] Tables (71)

17 dbo AWBLidVersion (1)

[1=] dbo.Databaselog (1,557)

[[1=] dbo.Emorlog (0)

[1=] HumanResources.Department (16)
[(1=] HumanResources.Emplayes {250)
[ HumanResources. Employee Departmerr
[1=] HumanResources. EmployesPayHistory
[1=] HumanResources.JobCandidate (13)
[ HumanResources.Shift (3)

10 £14%

Show S0OL script

[][=] Person.BusinessEntityAddress (19,614)
[1=] Person.BusinessEntityContact (309)
[1=] Person.Contact Type (20)

[C]=] Person.CountryRegion (238)
[1=] Person.EmailAddress (19.572)
[C1=] Person.Password (19.572)

[C]=] Person.Persen {13,572)

[C1=] Persen.PersenPhone (19,972}
[1=] Person.PhoneNumberType (3)
[[]=] Person.StateProvince (181)

[1] Production. BillOfMaterials (2,675}
[1=] Production Culture (8)

[(1=] Production.Document (13)

[(1] Production. llustration (5}

Address|D

W oo~ MOk

=

AddressLine1

1570 Napa Ct

5833 Mt. Dias Blv.
7484 Roundtree Drive
5539 Glenside Dr
1226 Shoe St.

1359 Firestone Drive
5672 Hale Dr.

6387 Scenic Avenue
8713 Yosemite Ct.
250 Race Court
1318 Lasalle Street
5415 San Gabriel Dr.
5265 La Paz

8157 W. Book

4912 La Vuelta

40 Hlis 5t.

6656 Anchor Drive
1873 Lion Circle
3148 Rose Street
6872 Thomwood Dr.
5747 Shirey Drive
636 Vine Hill Way
6657 Sand Pointe Lane
80 Sunview Temace
5178 Jumping St
5725 Glaze Drive

AddressLine2

NuLL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL

City
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Portland
Seattle
Duiuth
Dallas
San Francisco

StateProvincelD

et R I R R v v v R R R e R v v R R B e v - -

w

PostalCode

58011
58011
58011
58011
58011
58011
58011
58011
58011
58011
58011

SpatialLocation ™

(E6100000010C.
(xE6100000010C
(xE6100000010C
(xE6100000010C
(xE6100000010C
(xE6100000010C
(xE6100000010C
(xE6100000010C
(xE6100000010C
(xE6100000010C.
(xE6100000010C
(xE6100000010C
(xE6100000010C
(xE6100000010C.
(xE6100000010C.
(xE6100000010C
(xE6100000010C
(xE6100000010C.
(xE6100000010C
(xE6100000010C
(xE6100000010C
(xE6100000010C
(xE6100000010C
(xE6100000010C
(xE6100000010C

xE6100000010C ¥
>

Completed

Any particular row can also be scripted via context menu. By right click on the row, SQL script can be either
shown or at once copied to clipboard.
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File  Options Help

/ ﬂ‘,‘v H Search in Person Address | p |

Browse
=-[]e) AdventureWorks2012_CS_Data.mdf AddressID  AddressLine Addressline?  City StateProvincelD  PostalCode  SpatialLocation  #

éEg 'T'ambglem;n-:i;‘la}bllw @ 1970 Mapa Ct. NULL Bothel 98011 (xE6100000010C.
1 dbo AWBuidVersion (1) 9833 M. Dias Blv. NULL Bothel 98011 E6100000010C
1 dbo DatabassLog (1.597) 7484 Roundtree Drive NULL Bothel 98011 (xE6100000010C
)] dbo ErorLog (1) 9539 Glenside Dr NULL Bothel 38011 (xE6100000010C
] HumanResources Departmert (15) 1226 Shoe 5t. NULL Bothel 98011 (xE6100000010C
[ ]/ HumanResources.Employee (230) 1399 Firestone Drive NULL Bothel 98011 (xE6100000010C
5672 Hale Dr. NULL Bothel 38011 (xE6100000010C

[[]=] HumanResources.Employee Departmert
[1=] HumanResources. EmployesPayHistory 6387 Scenic Avenue NULL Bothell 58011 (xE6100000010C

0O = oW =
progp R R R g e

1] HumanResources.JobCandidate (13) Bothell 75 [san (xE6100000010C]

1] HumanResources. Shift (2) Copy 50L script to clipboard Bothell

58011 xE6100000010C.
58011 (xE6100000010C
58011 (xE6100000010C
58011 xE6100000010C
58011 (xE6100000010C.
58011 (xE6100000010C.
58011 <E6100000010C
58011 (xE6100000010C
(xE6100000010C.
<E6100000010C
(xE6100000010C
(xE6100000010C
<E6100000010C
(xE6100000010C
(xE6100000010C

M| Person Address (19.614) Show SOL script Bothell
[C1=] Person.AddressType (5} S Bothell
[ Person BusinessEnty (20.777) 1 Search for similar data Dot
= Person.BusfnessEm:rt)'Address !:1 9.614) Search for data related to [Address|D] Bothel
= Person.BusmessErﬂrtyF}orﬂad (909) 2917 La Vueha WULL Bothell
L] Person Contact Type (20) 40 Ellis St. NULL Bothel
[C1=] Persen CourtryRegion (238) )
17 Person. EmailAddress (19.972) 6696 Anchor Drive UL Bothel
. 1873 Lion Circle NUEL Bothell

[C1=] Person.Password (19.572)
1] Person.Person (19,972) 3148 Fose Street NULL Bothell

1] Person.PersonPhone (13.372) 6872 Thomwaod Dr. NULL Bothel
[C1=] Person.PhoneNumberType (3} 5747 Shirley Drive NULL Bothell
[[]=] Person.StateProvince (181) 636 Vine Hill Way NULL Portland
[1] Production. BillOfMaterials (2,675} 23 6657 Sand Pointe Lane NULL Seattle
[1=] Production Culture (8) 80 Sunview Temace NULL Duluth
[ Production.Document (13) 25 5178 Jumping St NULL Dallas xE6100000010C
[(1] Production. llustration (5} 5725 Glaze Drive NULL San Francisco xE6100000010C ¥
< >

dedfddddddddddI

w

Completed

Rows filtering provides the ability to easily find specific values in tables. To enable filtering, just start typing
necessary data, when focus is on the list or press Ctrl+F keys. Please note that rows filtering works only for
rows that was already loaded in current view.

File  Options Help

/ ﬂ‘,‘v H Search in Person.Address | jol |
i

Browse
E-[]v) AdvertureWorks2012_CS_Data.mdf AddressID  AddressLine1 Addressline2  City StateProvincelD  PostalCode  SpatialLocation

=00 imbglmml‘:b"“ @ 6872 Thomwaad Dr. NULL Bothel 38011 [E6100000010C034
B"D%[:i :;ol::\V};l’BuildVersion ) 5663 Irormood Way NULL Kenmare 98028 <E6100000010C764
] dbo Databaselog [1.'55?} 591 Memiewood Drive NULL Snohomish 58296 (xEG100000010C104
1] dbo.ErorLog (0) 7726 Driftwood Drive NULL Monroe 58272 E6100000010CC44
1] HumanResources.Department (16} 9693 Mellowood Street NULL Duvall xE6100000010C20¢

1] HumanResources. Employee (290) 390 Ridgewoed Ct. NUEL Camation 58014 (xE6100000010C8E7

[1=] HumanResources. EmployeeDepartment

[ HumanResources.EmployeePayHistory

[1=] HumanResources.JobCandidate (13)

[(1=] HumanResources.Shift ()

e P s (15614

[C1=] Person.AddressType (5}

[1=] Person.BusinessEntity (20,777}

[1=] Person.BusinessEntityAddress (19.614)

[1=] Person.BusinessEntityContact (309)

[1=] Person.Contact Type (20)

[C1=] Persen CourtryRegion (238)

[][=] Person.EmailAddress (13,572)

[C1=] Person.Password (19.572)

[1=] Person.Person (19.572)

[C]=] Person.PersonPhene (19.572)

[1=] Person.PhoneNumberType (3)

[1=] Person.StateProvince (181)

] Production BilOfMaterials (2.573) [woo | [Where Al

[1=] Production Culture (8)
Production. Document (13) . | 4 =

EE Production. llustration (5} e e

£ £

Completed
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4.1.2 Using search

Axcient DirectRestore provides several ways to search for data:

e Standard search

e Search for related data

¢ SQL Query search

To access the Search tool, select a table where the search will be performed and click on the Search Bar (1)
located at the top of the window.

File  Options Help

Gxa_art:h in Person Address : p—)

Browse
=13 AdventureWorks2012_CS_Data.mdf ~ | AddresslD  AddressLine Addressline2  City StateProvincelD  PostalCode  Spatiallocation
@[]0 Programmabilty (£) 1970 Napa Ct. NULL Bothell 38011 xE6100000010C.

2-L103 Tables (71) 9833 M. Dis Blv. NULL Bothel 38011 E6100000010C

[ dbo AWBuildVersion (1) )
[]] dbo.Databaselog {1,557) 7484 Roundtree Drive NULL Bothell 52011 E6100000010C
. 98011 Q<E6100000010C

C1 dbo Erorlog (0) 9539 Glenside Dr NULL Bothell
[J] HumanResources Departmert (16) 1226 Shoe &t. NULL Bothell 38011 <E6100000010C
[17=] HumanResources.Employee (290 1339 Firestone Drive NULE Baothell 58011 (xE6100000010C
[ HumanResources EmployeeDepartmer 5672 Hale Dr. NULL Bothell 38011 <E6100000010C
[1=] HumanResources. EmployesPayHistory 6387 Scenic Avenue NUEL Bothell 93011 (xE6100000010C
[ HumanResources JobCandidate (13} 8713 Yosemite (it NULE Bathell 58011 (xE6100000010C
[(1=] HumanResources.Shift () 250 Race Court NUEL Bothell 58011 (xE6100000010C.
|| Person. Address (19.614) | 1318 Lasalle Street NULL Bothell <E6 1000000100
[[]7=] Person.AddressType (5) 5415 San Gabriel Dr NULL Bothell (beER100000010C
[[]=] Person.BusinessEntity (20,777 13 9265 La Paz NULL Bothell xE6100000010C)
[][=] Person.BusinessEntityAddress (19.614) 8157 W. Book NULL Bothel E6100000010C
[]7 Person BusinessEntityContact (305) 4912 La Vuska NULL Bothel [<E6100000010C.
E% E:::'g:“;z;‘gieofgs\g} 4D Blis St NULL Bothel <E100000010C
: ; 6696 Anchor Drive NULL Bothell <E6100000010C
<E6100000010C:

Person EmaiAddress (19,572
Eg oo oot 12575 ! 1873 Lion Circle o Bothel
' 97 GE6100000010C
(<E5100000010C

] Person.Person (15.972) 3148 Rose Street NULL Bothell
[EE100000010C

(xE6100000010C

(xE6100000010C

xE6100000010C

(xE6100000010C

xE6100000010C ¥
>

[]] Person. PersonPhone (19,372) 6872 Tnomiood Dr. AULL Bothel

[CI=] Person.PhoneNumberType (3) 5747 Shiriey Drive NULL Bothell
[C1=] Person.StateFrovince (181) 636 Vine Hill Way NULL Portland
[ Production. BillofMaterials (2,673} 6657 Sand Pointe Lane NULL Seattle
[ Production Culture (2} 80 Sunview Temace NULE Duluth

[(1=] Production.Document (13) 9178 Jumping St NUEL Dallas

[(1] Production. llustration (5} 5725 Glaze Drive NULL San Francisco

et I e e v v v R B e v v v R R e i v - e R R

w

£
Completed

Search results will be displayed on separate tabs with the ability to select query results and export them either
into Live SQL Server or in the form of SQL script files which can be executed on server manually.
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File

]
& =
Search1 X

Options  Help

Search in Person Address

Address|D

W oo - MW=

10
1Al

ra

ZREENNZESaaRa

&

°

AddressLine1

1570 Napa Ct.

5833 Mt. Dias Blv.
7484 Roundtree Drive
3539 Glenside Dr
1226 Shoe St.

1359 Firestone Drive
5672 Hale Dr.

6387 Scenic Avenue
8713 Yosemite Ct.
250 Race Court

1318 Lasalle Street
5415 San Gabriel Dr.
5265 La Paz

8157 W. Book

4912 La Vuelta

40 Eliis St.

6656 Anchor Drive
1873 Lion Circle

3148 Rose Street
6872 Thomwood Dr.
5747 Shirey Drive
1502 Santa Cruz
59300 223rd Southeast
25111 228th 5t Sw
5509 Newcastle Road
7057 Striped Maple Court

Addressline2

MULL
NULL
NULL
MULL
NULL
NULL
NULL
NULL
NULL
MULL
NULL
NULL
MULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL

City

Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bathell
Bothell
Bothell
Bathell
Bothell
Bothell
Bothell
Bothell
Bothell
Eothell
Bothell
Bothell
Eothell
Bothell
Bothell
Bothell
Bothell

pror R R R e i - R v R e B e v - i R e e . v - R R e

StateProvincelD

PostalCode

58011
5301
5301
58011
5301
5301
58011
5301

SpatialLocation

(xE6100000010CAESBFC28B!
(xE6100000010CDEFABSTAE!
(xE6100000010C18E304C4AL
xE6100000010C813A0DSFIF
(xE6100000010C61C64D8AB
(xE6100000010CEDB4ESD45¢
xE6100000010C18E304C4AL
(xE6100000010C0023A5D93E
(xE6100000010CEAB0ADT42]
xE6100000010C213064AE1
(xE6100000010CCEFFBEFDS
(xE6100000010CEAB0ADT42]
xE6100000010CC3228C0867
(xE6100000010C213064AE1I
(xE6100000010C213064AE1I
«E6100000010CF76E45EFCE
(xE6100000010C034CT5E402
(xE6100000010C213064AE1I
(«<E6100000010C813A0D5FS
(xE6100000010C034CT5E402
(xE6100000010CEBS115FAS(
«E6100000010C96D15C3E4
(xE6100000010C5755A5215C
(xE6100000010C6552336E16
(<E6100000010C0029A5D33E

(xE6100000010C034CT5E402 ¥
>

Completed

Standard search mode
To access Standard search click on the Search Bar and select 'Standard search' tab in the displayed window.

File ~ Options

& =
Browse

Help

Search in Person Address

Flease enter search parameters.

2 Juy AdventureWaorks2012_CS_Data mdf
o-[_JZa Programmability (4)
- ]Cm Tables (71)
17 dbo AWBLidVersion (1)
[[]=] dbo.Databaselog (1.537)
[(1=] dbo EmarLog (D)
[1=] HumanResources.Department (16)
[ HumanResources.Employee (230)
[1=] HumanResources. EmployeeDepartment
[1=] HumanResources. EmployesPayHistory
[ HumanResources JobCandidate (13}
[(1=] HumanResources.Shift ()
[p | Peson Adees (3614)
[T]=] Person.Address Type (5}
[1=] Person.BusinessEntity (20,777}
[1=] Person.BusinessEntityAddress (19.614)
[1=] Person.BusinessEntityContact (309)
["1=] Person Contact Type (20)
[C1=] Persen CourtryRegion (238)
[1=] Person.EmailAddress (19.572)
[ Person.Password (19,572)
[1=] Person.Person (19.572)
[C1=] Persen.PersenPhone (19,972}
[CI=] Person.PhoneNumberType (3)
[1=] Person.StateProvince (181)
[1] Production. BillOfMaterials (2,675}
[ Production Culture (2}
[(1=] Production.Document (13)
[(1] Production. llustration (5}

£

Address|D

W oo~ M kW k=

- =

=]

AddressLine1

1570 Mapa Ct.

5833 Mt. Dias Blv.
7484 Roundtree Drive
5539 Glenside Dr
1226 Shoe St.

1355 Firestone Drive
5672 Hale Dr.

6387 Scenic Avenue
8713 Yosemite Ct
250 Race Court
1318 Lasalle Street
5415 San Gabriel Dr
5265 La Paz

8157 W. Book

4912 La Vuelta

40 Hliis 5t.

6656 Anchor Drive
1873 Lion Circle
3148 Rose Street
6872 Thomwood Dr.
5747 Shirey Drive
636 Vine Hill Way
6657 Sand Pointe Lane
80 Sunview Temace
5178 Jumping St
5725 Glaze Drive

Standard search

Relsteddats | SQL |

Fields to search:
() Alindexed figlds
() Allfields

Multiple field match type:

(® OR, records with one or more matching fields
(") AND, records with matches in all searched fields

Fields:
[] AddressID

[[] Addressline1
[[] Addressline2
[ cy

[] StateProvincelD

[[] PostalCode

o

(®) Custom (indexed only)
() Custom

Prefill

Clear

vanas

San Francisco

AU TUUUUUT T

xE6100000010C ¥
>

Completed

There are three sets of parameters to customize for this search:

Fields to search (1)
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This options defines the set of fields which will be used to perform search. The user can choose to search in all

indexed fields, all fields, custom selection from indexed fields or custom selection from all fields.

Multiple field match type (2)

In case more than one field is selected for search the user can choose which logical operator will be used to

combine these fields.

e OR - search results will include records which have at least one field that matches search parameters.

¢ AND - search results will include records which have matching values in all fields which were selected for
search.

Fields (3)

If Custom (indexed only) or Custom was selected in Fields to search the user will be able to choose fields

which will be used for search. To select a field simply click on the field name, the field will then become

selected and the user will be able to choose which comparison operator to use and to enter the value to search

for.

There are also two ways to fill search fields with values from selected tow, which helps to awid entering long

string manually:

¢ Right-click on a row and select Search for similar data from context menu. This fill set the field selection to
Custom and fill search from with values from selected row.

OR

e Select a row, then select Standard search tab and click Prefill button.

Search for related data

Search for related data can be used to search for rows which relate to the selected row - that are rows which
have fields from the selected table as foreign keys.

Related data search can be accessed either by right-clicking on a row and selecting Search for data related
to... from context menu or by selecting Related data tab in search window.

Yy Axcient DirectRestore - oIEN
File  Options  Help
u
Search in Person Address p
Flease enter search parameters.
Browse
= D w3 AdventureWorks2012_CS_Data.mdf # | AddresslD  AddressLinel i Standard search Related data saL
- ]E3 Programmabiity (4) 1 1970 Napa Ct i - 1
&[] Tables (71) . — i Fields:
..... 171 dbo AWBuidVersion (1 2 9833 1. Dias Bv.. | AddressiD )
o o 7 oundtree Drive / \
----- [1=] dbo.Databaselog (1,557 i ;:i:gl ddt DD I i o)
i enside Dr 4
""" [[17=1 dbo.EmorLog {0) 5 1226 Shos St | Related tables:
----- [(1=] HumanResources.Departme o€ St ’ ) . 9
..... ] HumanResources. Employse 6 1399 Firestone Drive / Person BusinessEntityAddress [Address|D] /)
----- [1=] HumanResources. EmployeeDepartment 7 5672 Hale Dr. / 7 il - TShi
..... 1] HumanResources EmployecPaytistoy 8 £387 Scenic Aventis A Sales.SalesOrderHeader [Bil ToAddressID]; [Ship ToAddress|D]
----- [[]=] HumanResources.JobCandidate (13) 9 8713 Yosemite Ct. i
----- [(1=] HumanResources.Shift (2) 10 250 Race Court /
----- = 1 1318 Lasalle Strest / \ 4
----- [C1=] Person.Address Type: (5) 12 5415 San Gabriel Dr. 4
..... [(1=] Person.BusinessEntity 13 9265 La Paz /
..... [C1=] Person.BusinessEntityAddres 14 2157 W. Book A
..... O/ Eerson.gusinesfrﬁﬁthﬁo.mad I 15 4312 La Vuelta /
----- [1=] Person.Contact Type (20 16 20 Hlis §t. 1
7 6696 Anchor Drive 4
18 1873 Lion Circle 4
19 3148 Rose Strest 4
..... [1=] Person.PersenPhone | 2) 2 6872 Th.omwoo.d Dr. !
----- []=] Person.PhoneNumber Type (2) 21 5747 Shidey Drive 4
----- [C1=] Person.StateProvinee (18 2 636 Vine Hill Way U
----- [1=] Production. BilOfMaterials (2,673) 23 6657 Sand Pointe Lane ! .
..... 1] Production Culturs: (2) 24 80 Sunview Temace 4 FEL Search Cleer
----- [(1=] Production.Document (12 25 9178 Jumping St forr Caias o roeu WG TUTOTT U
---- ] Production llustration (5] V|26 5725 Glaze Drive NULL San Francisco 5 54105 (xE6100000010C ¥
< > < >
Completed

The application will analyze the selected table and automatically detect which fields are used in other tables as
foreign keys (1). It will also provide a list of tables which relate to the selected table (2).
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X

The user will then be able to enter field values which will be used when searching for related data and select
from a list of tables where to perform search.

SQL Query mode

SQL Query search mode provides the ability to write complex search queries using SQL-like query language to
narrow search results as much as possible.

SQL query mode can be accessed by clicking on Search Bar and selecting SQL tab.

-1

X Axcient DirectRestore
File  Options Help
u
y Search in Person Address p
Flease enter search query.
Browse
E||:|h; AdventureWorks2012_C5_Data mdf | AddressID  Addresslinel | Standard search Related data saL
- ]E3 Programmabiity (4) - |
&-ClCa Tables (71 1 1570 Napa Ct / SELECT * FROM Person Address WHERE
..... = dbo. AWBLidVersion (1) 2 3833 M. Dias Biv. 4
’ 4 Ea 3 7484 Roundtree Drive / i .
----- [1=] dbo.Databaselog (1,557 2 3539 Glenside D o_},
..... 1] dbo.EmorLog (0} enside Dr i
----- [(1=] HumanResources.Departme ) 5 1226 Shoe St. /
..... [1=] HumanResources. Employee (290) & 1339 Firestone Drive /
----- [ HumanResources EmployeeDepartmen 7 5672 Hale Dr. 4
----- [[1=] HumanResources. EmployeePayHistory | & 6387 Scenic Avenue /
----- [1=] HumanResources.JobCandidate (13) ] 8713 Yosemite Ct. /
----- [T HumanResources. Shift (3) 10 250 Race Court /
----- 1Al 1318 Lasalle Street 4
12 5415 San Gabriel Dr. 4 i
[1=] Person.BusinessEntity (20 13 92965 L3 Paz f B
..... [C1=] Person.BusinessEntityAddress | 14 2157 W. Book y ;:fa?ellem_erlhe remaining part ofth?jquerym;earch fqrfﬁtg ORL(
_____ ] Person BusinessEntityContact b 2912 Lo Vootia | I e:=o ?:vlnlg ?Epevators are supported in search queries: LOR() -9_},—.
----- = Person.CordadT‘,'px.a (20) 15 40 Ellis St 1 Examples: ) )
----- [[1=] Person.CourtryRegion - 6656 Anchor Dri | 1) Department="Engineering’ AND Age=42
..... 17 Person. EmailAddress | ! nenor Sive 1| |B) Name="Steve’ OR Salary>=100000
_____ 1] Person Password ( 18 1873 Lion Circle / ) (Department="Marketing’ OR Posttion="Intem’} AND Age<30
o= Person.Person 13 19 3148 Fose Street 4 ) Salary=100000 OR (Department="Engineering’ AND (YearsOf Service<t OR
. L + i 'ostion="Intem )
2 6872 Thomwood Dr. | |B) Department LIKE “tketing' OR: (Postion LIKE *_rtem’ OR Postion LIKE
2 5747 Shirey Drive 4 ak]ntem’)
»
22 636 Vine Hil Way /
23 6657 Sand Pointe Lane i s
24 80 Sunview Temace 4 FEL gy oE
25 5178 Jumping St frorr s o roEuT AU TUUUTTT UG
V|26 5725 Glaze Drive NULL San Francisco 5 54105 (xE6100000010C ¥
£ > £ >
Completed

The user is presented with a text field (1) which is used to enter search query. The beginning of the query is
given and the user has to fill in the remaining part of WHERE clause.

The query may include field names, comparison operators, field values, logical operators and brackets. The
text field makes it easier for entering search query by providing auto-complete feature, which automatically
suggests possible query elements. The auto-complete window will appear automatically when first letters of
query are typed, it can also be accessed by pressing Ctrl+Space. To select an item (field name, logical or
comparison operator) from the list please press Tab or Enter.

Query examples are given at the bottom of the SQL tab (2).

4.2 Exporting items

Axcient DirectRestore allow a user to export the whole database or just particularly objects (tables, views,
functions, etc.) into live SQL Server and to SQL scripts, that can be used for manual import to a live sener.
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4.2.1 Restore to live SQL Server
Axcient DirectRestore includes the injection capability for items (tables, views, functions, etc.) from offline
database and BAK file to live SQL database.
The following options are presented:
¢ Authentication
e Connection to a database using valid credentials. To provide the connection, host (domain name or IP),
user logon name and password are required. It is also possible to connect through current Windows
credentials.
e Connecting to sewveral tables on different servers simultaneously.
e Browsing folder hierarchy of a connected database, browsing folder contents and viewing objects and rows.
¢ To provide injection, running the application as administrator or using a machine from AD domain, in which
there is SQL Server with destination database, is not required.

Connection to SQL Server
The mode, that allows connections to live server, is enabled by default. The Destination tab, as well as the
ability to connect to live server, can be hidden from the Options menu.

X Axcient DirectRestore - =
File | Options | Help
. Show notification panel S
/|| show progress dialog Search in Person.Address p E
Allow connections to live servers
Brow Destination
=L U " |~ AddressiD  AddressLine1 Addressline2  City Stal ~ No live servers connected
- ][ Frogrammabilty {2 1 1970 Napa Ct NULL Bothell 79 }
B"D‘E‘.la-rfso";'wu"dvmon . 2 3833 M. Dias Blv. NULL Bothel 7 Connect o alve server o enable
" EJ dbo DetabaseLog (1557 3 7434 Roundree Drive NULL Bothel 7 FXport o ShICIS 1fom Soure sterage.
_____ 1] dbo Erorlog (0] 4 5539 Glenside Dr NULE Bothell 7
_____ 1] HumanResources.Department (16) 5 1226 Shoe 5t NULL Bothell 7
..... [1=] HumanResources. Employee (290) 6 1359 Firestone Drive NUEL Bothell 7
..... []F] HumanResources EmployeeDepartmer |7 5672 Hale Dr. NULE Bothell 7
..... [1=] HumanResources. EmployesPayHistory 8 6387 Scenic Avenue NULL Bothell 7
----- [1=] HumanResources.JobCandidate (13) t] 8713 Yosemite Ct. NUEL Bothell 7
----- [[] HumanResources. Shift (3) 10 250 Race Court NULL Bothell 7
----- || Person Address (19.614) | 1 1318 Lasalle Street NULL Bothell 7
----- [[]=] Person.AddressType | 12 5415 San Gabrie! Dr. NULL Bothell 7
13 9265 La Paz NULE Bothell 7
14 8157 W. Book NULE Bothell 7
15 4512 La Vuelta NULE Bothell 7
16 40 Ellis 5t. NULE Bothell 7
7 6696 Anchor Drive NULE Bothell 7
_____ 1 Persan Password (1 18 1873 Lion Circle NULE Bothell 7
[ Person.Person (15, 13 3148 Rose Strest NULE Bothell 7
_____ 1] Person.PersonPhone (13 20 6872 Thomwood Dr. NULE Bothell 7
_____ 1] Person.PhoneNumberTyp 21 5747 Shirley Drive NULE Bothell 7
..... 1] Person.StateProvine | 22 636 Vine Hill Way NULE Portland 58
..... 1] Production BilofMaterials 3) 23 6657 Sand Pointe Lane NULL Seattle 7
..... [1=] Production Culture (2} 24 80 Sunview Temace NULL Duluth 36
----- [(1=] Production.Document (12 25 9178 Jumping St NUEL Dallas 7
----- [ Production. llustration (5} V|26 5725 Glaze Drive NULL San Francisco 9 ¥
< > < >
Completed

To establish a new connection, use the button Connect to live server (1), next to the Search field or go to
File->New connection->Attach to live SQL Server database (2).
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File | Options Help

Open file... Ctrl+ 0

Recent

Close file

Reload database using transaction logs

MNew connection 3 | ) Mo live servers connected.

Search for files to open... . actCa Connect to a live server to enable
export of objects from source storage.
Save selected objects into SOL scripts..  Cirl+5

Export into live server... Ctrl+E ersion: SQL Server 2012
Cancel current operation Ctrl+N
ansaction logs not used.
Open log folder
Delete saved temp files and logs tables. Select a table to display records

. ad time: 00:00:02
Exit

DE Person Address Type (5]

[[]=] Person BusinessErtity (20.777)

[1=] Person.BusinessEntityAddress (19.614)
[1=] Person.BusinessEntityContact (309)
[1=] Person.Contact Type (20)

[C1=] Persen CourtryRegion (238)

[1=] Person.EmailAddress (19.572)

[C1=] Person.Password (19.572)

[C]=] Person.Person {19,572)

[C1=] Persen.PersenPhone (19,972}

[1=] Person.PhoneNumberType (3)

[[]=] Person.StateProvince (181)

[1] Production. BillOfMaterials (2,675}
[1=] Production Culture (8)

[ Production.Document (13) <
[(1] Production. llustration (5}

< File info

Completed

To access the server, enter the domain name or the IP address, or just click on the arrow (1) to get the drop-
down list of automatically detected servers and provide valid credentials.

Server name (ex.: contoso.com*MSSALSERVER or 152168 0.5\MS5QLSERVER):

SQL201EENTER
WS201250L

Use cument Windows credentials
Please enter the server address and provide user

saLs Jogin fex - user ) credentials for connection.
The application wil then fetch the list of databases
available on the tanget server.

After that you will be able to choose the desired
database from the list and connect.

[] 5ave password

Diatabase name:

List of available databases will be shown after clicking the Refresh button (1) or the arrow near the Database
name field (2), if entered credentials are correct.
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Server name (g cortoso.com*MSSQLSERVER or 152,168 0. 5\M55QLSERVER):
\WS5201250L

v|| Refresh

[] Use cumrent Windows credertialz
Please enter the server address and provide user

SQL Server login (. userl): credentials for connection.

The application will then fetch the list of databases
available on the tanget server.

After that you will be able to choose the desired
database from the list and connect.

[] Save password

Database name:

AdventureWorks2012

Injection workflow
Once data has been selected, click the Export button and select an Export option.

File  Options  Help

u
/ 7 H |Seart:hin Person Address
Browse

=-[m] gy AdventureWorks2012_CS_Data mdf

AddressD  AddressLine1 =-£5 Ws2012s50L AddresslD  AddressLins1

£

t-[|C3 Programmability (4)
= [a]Em Tables (71)

1] dbo.AWBLidVersion (1)
[I=] dbo.Databaselog (1,557)
[ dbo.EmorLag (0}
[ HumanResources.Department (15)
[[]F=] HumanRescurces.Employee (250)
[ HumanRescurces. EmployeeDepartmen
[IF] HumanRescurces.EmployesPayHistory
[I] HumanRescurces.JobCandidate (13)
=] HumanResources. Shift (3}
B oo e 15616
[ Person.AddressType (5)
[CI=] Person.BusinessEntity (20,777)
[[]=] Person.BusinessEntityAddress (19.614)
[I=] Person.BusinessEntityContact (303}
[[]F=] Person Contact Type (20)
[I=] Person CourtryRegion {238)
[CI=] Person.EmaiAddress (19,972}
[[]F=] Person.Password (19,572)
[I=] Person.Persen (19.572)
[CI=] Person.PersonPhone (13,972
[ Person.PhoneNumberType (3)
[CI=] Person.StateProvince (181)
[[]=] Production. BillOfMaterials (2,675)
[ Production Cutture (8}
[ Production.Document {13)
[]F] Production. llustration (5)

W oo~ MWWk

1570 Napa Ct
5833 Mt. Dias Blv.
7484 Roundtree Dri
3539 Glenside Dr
1226 Shoe 5t.
13585 Firestone Driv
5672 Hale Dr.
6387 Scenic Avenu
8713 Yosemite Ct.
250 Race Court
1318 Lasalle Street
5415 San Gabriel D
5265 La Paz

8157 W. Book
4912 La Vuelta

40 Hllis 5t.

6656 Anchor Drive
1873 Lion Circle
3148 Rose Street
6872 Thomwood D
5747 Shirey Drive
636 Vine Hill Way
6657 Sand Pointe L
80 Sunview Temact
5178 Jumping St.

5725 Glaze Dive ¥
>

El-py AdventureWorks2012
-3 Programmability (4}
=3 Tables (71)

[ dbo AWBuildVersic

-.[=] dbo.Databaselog

./ dbo.EmorLog ()

--[=] HumanResources.

-.[=] HumanResources.

-.[=] HumanResources.

-.[=] HumanResources.

-.[=] HumanResources.,

-.[=] HumanResources.

M| Person. Address (1

[ Person Address Tyr

[ Person.BusinessEr

[ Person BusinessEr

[ Person BusinessEr

[ Person Contact Typ

[ Person CountryRec

[ Person.EmailAddre

.[] Person Password |

[ Person.Person (19

.[] Person.PersonPhoi

[ Person.PhoneNum

[ Person.StateProvir

[ Production. BillOfM:

[ Production.Cutture

[ Production.Docum: ¥

>

FREREBEZSJaorpmIae™ Moo hen-

<

1570 Napa Ct.

5833 Mt. Dias Blv.
7484 Roundtree Drive
3539 Glenside Dr
1226 Shoe 5t.

1353 Firestone Drive
5672 Hale Dr.

6387 Scenic Avenue
8713 Yosemite Ct.
250 Race Court
1318 Lasalle Street
5415 San Gabriel Dr.
5265 La Paz

8157 W. Book

4912 La Vuelta

40 Hliis 5t.

6696 Anchor Drive
1873 Lion Circle
3148 Rose Street
6872 Thomwood Dr.
5747 Shirey Drive
636 Vine Hill Way
6657 Sand Fointe Lane
80 Sunview Temace
5178 Jumping 5t.
5725 Glaze Drive

Completed

Selected: 1 object(s)

Axcient DirectRestore presents several injection modes for specified data:

o Export to original object - The source object will be restored to the object listed undélestination Object
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e Export to new Object - The user may edit thBestination Object for any source object, and the Axcient
DirectRestore application will create a new destination object to restore to.

e Schema only - Export only the schema of the source objects. The destination object can be edited and the
schema(s) will be restored to the new destination object.

¢ Unselect successfully exported objects - This will unselect the data objects that were selected for export

once they have been successfully exported to the live server. This will allow the user to more easily identify

which objects encountered errors and were not exported.

Destination database:
WS20125QL\ AdventureWorks2012

(Object names are valid. Click "Start’ to begin export.

Source object Destination object
EE [Person].[Address) [Persan].[Address] " Source table found Remove

(®) Bxport to original object (create f not exists) () Export to new object

[ ] Unselect successfully exported objects
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4.2.2 Restore to SQL scripts

To sawve objects marked for export, click the Export selected objects into SQL scripts button on the toolbar
or select the point in the File menu.

File  Options Help

u
= I I Search in Person Address | p |

=-[m] 3 AdventureWorks2012_CS_Datamdf AddresslD  AddressLine Addressline2  City StateProvincelD  PostalCode  SpatialLocation

=0 imbglmml‘:b"“ @ 1970 Napa Ct. NULL Bothel 38011 E6100000010C.
Bmﬁéﬁ :;ol::ﬁ‘}VBuil $Vesion (1 9833 M. Dis Blv. NULL Bothel 38011 E6100000010C
[ dbo DatabaseLog (1597) 7484 Roundtree Drive NULL Bothell 38011 (E6100000010C
C1 dbo Erorlog (0) 9539 Glenside Dr NULL Bothell 38011 <E6100000010C
[J] HumanResources Departmert (16) 1226 Shoe &t. NULL Bothell 38011 <E6100000010C
1] HumanResources Employee (230) 1355 Firestone Drive NULL Bothell 58011 eE6100000010C
1] HumanResourcss. EmployeeDepartmert 5672 Hale Dr. NULL Bothell 38011 <E6100000010C
[1=] HumanResources. EmployesPayHistory 6387 Scenic Avenue NUEL Bothell 93011 (xE6100000010C
[ HumanResources JobCandidate (13} 8713 Yosemite (it NULE Bathell 58011 (xE6100000010C
]/ HumanResources. Shift (3) 250 Race Court NULL Bothell 98011 (xE6100000010C
|| Person Address (19.614) 1318 Lasalle Street NULL Bothell (xE61000000100
[[]7=] Person.AddressType (5) 5415 San Gabriel Dr NULL Bothell (beER100000010C
[]] Person BusinessEntty (20.777) 9265 La Paz NuLL Bothel <EE100000010C)
[ Person BusinessEntityAddress (19.614) 8157 W. Book nuLL Bothell DEETD000001LC,
{_]=] Person BusinessEntiyCortact (309) 4912 La Vueta nuLL Bothell DEETD000001LC,
EE E:::'g::z;g?ofgs\g} 4D Blis St NULL Bothel <E100000010C
1 Person Emaiiddress (19.572) 6696 Anchor Drive NULL Bothell <E6100000010C
1] Person Password (19.572) 1873 Lion Circle NULL Bothell <E6100000010C:
[ Person. Person (13.572) 3148 Rose Street NULL Bothell <E6100000010C
1 Person PersonPhone (19.972) 6872 Thomwood Dr. NULL Bothell <E6100000010C
[ Person PhonshumbsrTyps (2) 5747 Shifey Drive NULL Bothell <E6100000010C
[1] Person.StateProvince {121) 636 Vine Hil Way NULL Portland (xE6100000010C
1] Production. BilofMaterials (2.679) 6657 Sand Poirte Lane NULL Seattle <E6100000010C
[ Production Culture (2} 80 Sunview Temace NULE Duiuth xE6100000010C

9178 Jumping 5t NULL Dallas <E6100000010C

5725 Glaze Drive NULL San Francisco xE6100000010C ¥

>

et I e e v v v R B e v v v R R e i v - e R R

[(1=] Production.Document (13)
[(1] Production. llustration (5}

ARBEENRBENBEZsdan RPN RwN -
w

£
Completed Selected: 1 object(s)

To start exporting process, select destination folder or create a new one and click OK.

Selected data will be saved into SGL script(s). To start the export select the
destination folder or create a new one and click OK. The export process will start
immediately.

| Dacuments

& Downloads
I+ | ¢ Favorites

P Links

W Music
I | & Pictures

# Saved Gamnes
I & Searches

H Videos

| Make Mew Faolder

Required time depends on how many objects are selected for export. By default, a progress window appears
after the export starts. The window shows the number of saved objects and rows (1). You can disable the
progress window directly in the window or go to the Options menu and select Show progress dialog.

The export can be cancelled by clicking an appropriate link in the progress dialog window (2) or by clicking the
Cancel export button on the taskbar (3).
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Yy Axcient DirectRestore = B
File  Options Help
l H ! Search in Person Address p
Browse
=¥ ey AdventureWarks2012_CS_Data mdf A BAdracalN  Addrasel inal LAdracel ina? i StateProvincelD  PostalCode  Spatiallocation ™
[W¥IC3 Programmahility () Progress 79 98011 xE6100000010C
=[] Tables (71} - i
[ dbo AWBuidVersion (1) » sent B<E6100000010C
[=] dbo Databaselog (1,557} Exporting objects... 94% ;: 2:5:‘]:‘] téi:} gggggg}g
[=] dbo EmorLeg (0) \ !
[7] HumanResources Department (16} ables o 7 S8 (EE100000010C
=] HumanResources Emplayee - - 73 58011 (E6100000010C
[=] HumanResources. EmployeeDepartmer ndexes 73 38011 (=xE6100000010C
] HumanResources. EmployesPayHistory | Constraints 7 79 98011 (xE6100000010C
=] HumanResources JobCandidate (12) Types 6 79 38011 (xE6100000010C
[ HumanResources. Shift (3) Rows 716.92 79 98011 [bcE61 00000010
&= Person Address (19.614) Read speed 459 KB/ 79 58011 (xE6100000010C
[] Person AddressType | Elapsed time 00:01:33 75 58011 (E6100000010C
[=] Person BusinessEntity 73 38011 xE6100000010C
[ Person.BusinessEntityAddress (19,614 79 98011 xE6100000010C.
; EEBUﬂ-gUiniifrEmWEf‘maﬁ L _ 75 52011 xE6100000010C
‘erson. Contact Type (20) \ -
=] Person CourtryRegion (232) S I 9 79 58011 EE100000010C
] Person. EmailAddres 73 58011 (E6100000010C
= Person.Password Show the dialog next time Close 79 58011 (E6100000010C.
= Person.Person | 75 58011 (E6100000010C
’ 72 Thomwood Dr. / othe 7
=] Person.PersonPhone | 20 6872 Th d D NULL Bothell ] 58011 (E6100000010C
. 747 Shiey Drive / othe! 7
=] Person.PhoneNumber Typ 21 5747 Shirley D NULL Bothell ] 58011 (E6100000010C
] Person.StateProvince (12 22 636 Vine Hil Way NULL Portland 58 97205 (E6100000010C
[ Production BilOfMaterials (2,679) 23 6657 Sand Pointe Lane NULL Seattle 75 58104 (<E6100000010C
Production Culture (2) unview Temace / it
(8) 24 80 5 Te NULL Duiuth 36 55802 (E6100000010C
.. =] Production.Document (13) 25 5178 Jumping St NULL Dallas 73 75201 <E6100000010C
----- [W]=] Production. llustration (5) V|26 5725 Glaze Drive NULL San Francisco 5 54105 (xE6100000010C ¥
< > < >
Exporting objects... 94% | . | 000133 Selected: 95 object(s)

Tip
If you closed the progress window, it can be shown again by clicking on the progress bar on the status
panel.

Restoring exported scripts into SQL Server

SQL scripts exported from the offline database can be easily imported into live SQL Server manually

For this purpose a special bat-file, commit.bat, is generated while extracting data. It is stored in the folder with
restored scripts.

Usage for trust connection:

commit.bat server name db name

Usage for mistrust connection:

commit.bat server name db name user name password

5 Axcient DirectRestore. Exchange Server

5.1 Special features

Usage of Axcient DirectRestore can be more comfortable for a user due to additional Options menu, which
allows user to customize program work.
Detailed information about every option is described in this help section.

Note
PST encoding and Show deleted items options are not available for PST/OST files.
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5.1.1 PST encoding

Exporting mail store data into PST allows to select a PST format that suits your version of Microsoft Outlook.
Outlook 2003, Outlook 2007, Outlook 2010 and Outlook 2013 process both Unicode and ANSI PST files, but
as for older versions of Outlook, they will not be able to open Unicode formatted PST files. Previous versions of
Outlook were using only ANSI format. The main reason for this change was to allow for international character
support and to extend the maximum size of PST files beyond the 2GB limit of the ANSI formatted PST files.

In Axcient DirectRestore there are two ways to select suitable encoding for output PST.

Output PST encoding can be changed while selecting a destination folder for restored PST files.

Selected data will be saved into pst file(z). To start the export select the destination
folder or create a new one and click OK. The export process will start immediately.

4 || Recovered "
o CLIENT-PC
, Recovered_session
) Recovered_session?
, Recovered_seszion3
, Recovered_sesziond
, Recovered_session3

. Recovered_zeszionb

[ TestComnlete Testnlans

Jnicode (Microsoft Outlook 2003, 2007, 2010 and 2013)

Make New Foldsga S \icrosoft Dutlook 2002 and earlier) ;

Alternatively, encoding for the output file can be changed in the Options menu at any time the program runs.
Selected value will be saved and used on the next program launch.
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Options | Help

Show mailbox mismatch warning in expert mode

Show delete folder warning in expert mode Select mailboxes orfolders to search

Show notification panel

Show progress dialog
Allow connections to live servers Database.edb

Search within attachments ge Server Database\Mailbox Database.edb
PST encoding F Unicode (Microsoft Outlook 2003, 2007, 2010 and 2013)

Incomplete messages ANSI (Microsoft Outlook 2002 and earlier)

Show deleted items 4
Display time , In logs not used.

Updates 3

xes. Select a mailbox to display folders.

5[] Luise Load time: 00:00:04

[]£9 Maria Woods

[J&9 Michael Display time: GMT

]9 Personal Archive - HealthMailboxadeSae eb! PST encoding: Unicode (Microsoft Outlook 2003, 2007, 2010 and 2013)

]9 Personal Archive - HealthMaiboxbaa8042e260 Show deleted items: Only non-deleted items

]9 Richard Incomplete messages: Hide

]9 Robert Risz Search within attachments: Off

[]£9 Romeo Montague

[159 Rudy Raid

[J£9 Susane Tyler

[]&9 SystemMaibox{ade9ae 25548602 1cf-021
-] &9 Tim Goodler

< File info

Completed

5.1.2 Incomplete messages
Incomplete messages, such as messages with missing properties, bodies, are hidden by default. This option
can be changed in the Options menu.

Options | Help

Show mailbox mismatch warning in expert mode

Show delete folder warning in expert mode Select mailboxes orfolders to search

Show notification panel

Show progress dialog
Database.edb

Allow connections to live servers

Search within attachments ige Server Database\Mailbox Database.edb

PST encoding Mb

Incomplete messages

Show deleted items
Display time

Ui xes. Select a mailbox to display folders.
5[] Luise Load time: 00:00:02

[]£9 Maria Woods

[J&9 Michael Display time: GMT

]9 Personal Archive - HealthMailboxadeSae eb! PST encoding: Unicode (Microsoft Outlook 2003, 2007, 2010 and 2013)

]9 Personal Archive - HealthMaiboxbaa8042e260 Show deleted items: Only non-deleted items

]9 Richard Incomplete messages: Hide

]9 Robert Risz Search within attachments: Off

[]£9 Romeo Montague

[159 Rudy Raid

[J£9 Susane Tyler

[]&9 SystemMaibox{ade9ae 25548602 1cf-021
-] &9 Tim Goodler

File info

£
Completed

Note
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After changing the way of displaying incomplete items, the database will be reopened

5.1.3 Showing deleted items

Axcient DirectRestore provides an ability to process deleted items and folders.

This special feature can be enabled via the Options menu. There are three available display modes:

¢ non-deleted items - displays actual items in folders;

¢ show only deleted items - displays items/folders deleted from a mailbox hierarchy, but not physically ;

¢ show both deleted and non-deleted items - displays both actual items in folders and items/folders deleted
from a mailbox hierarchy.

Note that after selecting any way of processing deleted items, the database will be reopened.

ltems, deleted from Exchange Server 2010 and 2013 databases, are stored in the folder Deletions and have an

appropriate type.

e Axcient DirectRestore = =
File Options Help

~~

Search in Andrew Wai
7 Search in Andrew Wait yeol

Browse
=-[]4) Maibox Dats db AT T 0 Subject Fom  To Created
Ej /N”;NS::(“E‘“E'V ou=Exchange Adminisiat f - ¢ JESSICAlamsonythou  Dala  Romeo Montague; Tim Gooder; Maria . Thursday, August 16, 2012 3:00-17 A...
El’:l.ﬂ Andrew Wait ] ABHORSON Do you call Michael  Andrew Wait; Susane Tyler; Juliet Cap... Thursday, August 16, 2012 3:.00:12 A .
----- [](£H Calendar (0)
----- [ 22] Contacts (0)

..... []Ea Junk E-Mail (0
..... [li Motes (0)

[
m-[]£&) Brian

w-[]£9 Dalia

-9 John

-] Juliet Capulet

-5 Kyle Pakeman

w15 Luise

-] &9 Maria Woods

-] &9 Michael

-] &9 Richard

([ £9 Robert Rise

-] Romeo Maontague

@-[_|£5§ Rudy Raid v

£ > £ >
Completed

As for items deleted from Exchange Server 2007 databases, they are stored in the their original folders but can
be easily recognized by an appropriate status.

Note
Items, stored in the folder Deletions, cannot be recovered to live Exchange Server database. It is
recommended to restore items from the Deletion folder to PST and then import to live Exchange Server.
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5.1.4 Display time
There are two dates display formats available for users, local time and GMT.
To switch dates display format between local computer time and GMT, use the Options menu.

Options | Help

+ | Show mailbox mismatch warning in expert mode

«  Show delete folder warning in expert mode Search in Alex Clark

Show notification panel

Show progress dialog
L ﬂ Subject From To
& Allow connections to live servers

o She was glad that Jo shoul...  Luise Maria Woods; Kyle Pakeman; Luise; ... 'Wednesday, March 12, 2
Search within attachments ﬂ In itsnature, it is arbitrary an... Kyle Pakerman Andrew Wait; Richard; John; Dalia; Ro... Wednesday, March 12, 2
It is my lady mother. lis my... Juliet Capulet Romeo Mortague; Richard; Dalia; Mic... Wednesday, March 12, 2
Butthat it might not appeart... John Romeo Montague; Andy Kort; Robert ... Wednesday, March 12, 2
ReompleiSbesays Do you persuade yourself ... Andy Kort Susane Tyler; Andy Kort; Juliet Capulet... Wednesday, March 12, 2
Show deleted items | regret that | am unable tar... Brian John; Brian; Tim Goodler; Kyle Pakem... Wednesday, March 12, 2
Display time i Dalia; Kyle Pakeman; Michael; Susan... |Wednesday, March 12, 3
. Rudy Raid Brian; Michael; Richard; Dalia; Luise; T... Wednesday, March 12, 2
Romeo Montague  Brian; Alex Clark; Richard; Romeo Mon . Wednesday. March 12 2
L/ One of the things particular... Fobert Fise John; Maria Woods; Richard; Alex Clar... Wednesday, March 12, 2
] Tasks (48) {] Stephen Brice readthe ne...  Luise Aex Clark; John; Tim Goodler; Michael... Wednesday, March 12, 2
]Dﬁ Andrew Wait ﬂ Give me some light! Give m...  Michael Romeo Montague: Richard: Andrew W... Wednesday, March 12, 2
JD@ Andy Kort ﬂ His condition leaves him no... Juliet Capulet Romeo Montague; Richard; Juliet Cap... Wednesday, March 12,2 v
7[5 Brian >
o159 Dalia Alas, the heavy basketwhich the Colonel carried on his arm was x
-[_]9 HealthMaiboxadsSae Fe5b54860a1cf0218 " vy
H-[_] =) HealthMailboxbaaB042e260145aa928ba55 v
1] John From: Alex Clark E attachment(s):
2 [159 it Capuiet Sent  Wednesday, March 12, 2014 10:29:00 AM UTC-07:00 aJoR it 27518
H-[ ] =9 Kyle Pakeman - ) ) . || ESSAYS-Tixt, 222 KB
]Dﬁ Luise To: Dalia; Kyle Pakerman; Michael, Susane Tyler; Brian; Andy Kort; Juliet Capulet... I__l ESSAYS10.6¢t 120 KB

3l Dﬁ Maria Woads Co “Dalia” <Dalia@no-such-email.com>, "Kyle Pakerman” <Kyle.Pakerman@no... .
1-[_] =) Michael | ESSAYS-42 tet, 561 bytes

t1-[] =9 Personal Archive - HeatthMaiboxadeSae e By she did not lft her voice at dinner, which was very poor indeed for || ESSAYS-46.04. 208 KB
+-[_] =) Personal Archive - HealthMailboxbaaB042s.  Colonel Carvel's house. All day long Virginia. assisted by Uncls Ben and || ESSAYS-48.txt, 2.31 KB
]Dﬁ Richard Aunt Easter, toiled in the stifling kitchen, preparing dainties which !

[ ]=) Robert Rise The had lona denied herseff. At evenina she went to the station at

< Preview ‘ Properties |

PST encoding

Updates
[]ca Sent tems (0)

Completed

If you switch display time, a warning, that the file will be reloaded, appears.

Switching display time requires reloading the file. This may take a long time. Do you want to
continue ?

A message in GMT format looks the following way:
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File

=

Browse

Options

Help

(-.:}

Search in Alex Clark

= ]ey Mailbox Database edb
B[ J£9 Alex Clark

]2 Calendar (422)
[ 2] Contacts (45)
[ Deleted tems (25)
T2/ Deletions (D)
13 Drafts (0)
(Y Inbox (1.046) |
.4 Joumal (27)
Dl Junk Email (0)
[ Motes (40}
[l Outbax (0}
Dl Sent tems (0)
C1 3 Tasks (49)

From

Luise

Kyle Pakeman
Juliet Capulet

 Subject
She was glad that Jo shoul...
ﬂ In itsnature, it is arbitrary an...
It is my lady mother. 1 is my...
Butthat it might not appeart... John
Do you persuade yourself ... Andy Kort
| regret that | am unabletor... Bri
Alas, the heavy basketwhic...
He went up a dark and narr...
Noone, even there, could li...
One of the things particular...
Stephen Brice read the ne...
Give me some light! Give m...

Rudy Raid
Romeo Mortague
Robert Rise

Luise

Michael

an

To

Maria Woods; Kyle Pakeman; Luise; ...

Andrew Wait; Richard; John; Dalia; Ro...
Romeo Montague; Richard; Dalia; Mic...
Romeo Montague; Andy Kort; Robert ...

Susane Tyler; Andy Kort; Juliet Capulet...
John; Brian; Tim Goodler; Kyle Pakem...
Dalia; Kyle Pakeman; Michael; Susan...
Brian; Michael; Richard; Dalia; Luise; T...
Brian; Alex Clark; Richard; Romeo Mon...

John; Maria Wao,

Created

Wednesday, 12 Mar 201:
Wednesday, 12 Mar 201:
Wednesday, 12 Mar 201:
Wednesday, 12 Mar 201:
Wednesday, 12 Mar 201:
Wednesday, 12 Mar 201:
Wednesday, 12 Mar 201
Wednesday, 12 Mar 201:
Wednesday, 12 Mar 201:

Brian; Alex. Clark; Richard; Romeo Montague; Andy Kort

Alex Clark; John;

Romeo Montague; Richard; Andrew W... Wednesday, 12 Mar 201:

m&&m&&ﬁ&&&&&m%

[ ]£59 Andrew Wait

0[] Andy Kot

H-[_] 59 Brian

i[9 Dalia

H-[_] =) HealthMailboxade 9ae FeSb54860a1cf0218
H-[_] =) HealthMailboxbaaB042e260145aa928ba55
1] John

-] 9 Juliet Capulet

H-[ ] =9 Kyle Pakeman

H-[ ] Luise

-] 9 Maria Woods

1[5 Michael

Juliet Capulet Romeo Montague; Richard; Juliet Cap... Wednesday, 12 Mar 201: +

>

His condition leaves him no...

. DDDDDDDDDDDDD O

Alas, the heavy basketwhich the Colonel carried on his arm was x

w

& attachment(s):

[aZ]DR.gif, 275 KB

| ESSAYS-Tixt, 222 KB
| ES5AYS-10.tt, 1.20 KB
|| ESSAYS-42 txt, 561 bytes
|| ESSAYS-46.txt, 2.08 KB
| ES5AYS-431t 231 KB

Alex Clark

Wednesday, 12 Mar 2014 17:28:00 GMT l

Dalia; Kyle Pakerman; Michael; Susane Tyler; Erian; Andy Kort; Juliet Capulet...

"Dalia” <Dalia@no-such-email.com>, "Kyle Pakerman” <Kyle.Pakerman@&@no...

From:

gent:

To:
Cc:

But she did not lift her voice at dinner, which was very poor indeed for
]Dﬁ Personal Archive - HealthMailboxade9aeAe  Colonel Carvel’s house. All day long Virginia, assisted by Uncle Ben and
i-[_] 9 Personal Archive - HealthMailboxbaa8042e. | Aunt Easter. toiled in the stifling kitchen. preparing dainties which
JD.@ Richard w The had lona denied herself. A evenina she went to the station at

< > Preview ‘ Properties

Completed

5.1.5 Showing notification panel
Every program action is accompanied by an appropriate notification for user. Notification panel is disabled by
default, but can be easily enabled by checking Show notification panel in the Options menu.

Options | Help

+ | Show mailbox mismatch warning in expert mode

«  Show delete folder warning in expert mode Select maiboxes orfolders to search

Show notification panel

D

Database.edb

==} E
£

Show progress dialog

o

B e e e e e e e e

Allow connections to live servers

Search within attachments ige Server Database\Mailbox Database.edb

Mb
3/2014
wchange Server 2013

PST encoding
Incomplete messages
Show deleted items

Display time , In logs not used.

Updates 3

Dﬁ Luise

[ ]&9 Maria Woods
[ ]&9 Michael Display time: Local

-[J &9 Personal Archive - HealthMaiboxadeSae FeBb! PST encoding: Unicode (Microsoft Outlook 2003, 2007, 2010 and 2013)
-[]=9 Persoral Archive - HealthMailboxbaa80422260 Show deleted items: Only non-deleted items

-]y Richard Incomplete messages: Hide

-[]£9 Robett Rise Search within attachments: Off

[ ]£9 Romeo Montague

59 Rudy Raid

[ ]£9 Susane Tyler

i-[ ] SystemMaibox{adeSae -2 50548603 1cf-021
-] &9 Tim Goodler

xes. Select a mailbox to display folders.
Load time: 00:00:05

(e

File info |

£

Completed

After that user will see additional information about opening file, export results, search results, etc.
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File  Options Help

. 7—“ | I I'h | Search in Andy Kort and 2 more
=1}
Browse
=
[]&59 Andrew Wait

&9 Andy Kort
ﬁ Brian

Mailbox Database.edb

C:\Exchange Server Database\Mailbox Database.edb
Size: 904 Mb
Date: 3/13/2014

159 HeathMaiborads9as e5b54860a1ci0213267 Version: Exchange Server 2013
[J£9 HealthMaiboxbaaB042e260149aa528ba554s( .
159 John Transaction logs not used.
]9 Juliet Capulet
159 Kyle Pakeman 22 mailboxes. Select a mailbox to display folders.
£ Luise Load time: 00:00:03

[]£9 Maria Woods
[J&9 Michael Display time: GMT

[]£9 Personal Archive - HealthMailhoxadeSse Fe5b! PST encoding: Unicode (Microsoft Outlook 2003, 2007, 2010 and 2013)
]9 Personal Archive - HealthMaiboxbaa8042:260 Show deleted items: Only non-deleted items

]9 Richard Incomplete messages: Hide

Eg xbe“ ':115; Search within attachments: Off
| meo Montague

5 Rudy Raid
[J£9 Susane Tyler
Dﬁ SystemMailbox{ade 9ae F-e5b5-4860-a 1cf-021
-] &9 Tim Goodler

File info

151t ave -
/21/2019 12:51:42 AM] Exported 3 mai ), 33 folder(s) and 4,872 into C:\Recovered\CLIENT-PC\Recovery 001%.pst
(21/2019 12:50:48 AM] Database load time: 0 hour(s) 0 minute(s) 3 second(s)

-
Completed Selected: 3 mailbox(es)
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5.2 Finding and selecting messages, folders and mailboxes

Axcient DirectRestore provides two mutually complementary modes of finding, previewing and selecting items:
browsing the mailbox tree and search. Using these, it is possible to efficiently form a set of items for
subsequent export, including the necessary ones and excluding ones to be skipped.

A newly opened database is shown in the Browse mode.

DX

Axcient DirectRestore

- )

File  Options  Help

Browse

=09
-] =9 Alex Clark

[[1£9 Andrew Wait

[[1£9 HealthMailboxadeSae Febh54860a 10218267
[[1£9 HealthMailboxbaaBl42:26014%a5928ha554e(]

159 SystemMaibo{adeSae F-5h5-4860-a1cf-021
-9 Tim Goodler

< >
Completed

Select mailboxes orfolders to search

Mailbox Database.edb

C:\Exchange Server Database\Mailbox Database.edb
Size: 904 Mb

Date: 3/13/2014

Version: Exchange Server 2013

Transaction logs not used.

22 mailboxes. Select a mailbox to display folders.
Load time: 00:00:03

Display time: GMT

PST encoding: Unicode (Microsoft Outlook 2003, 2007, 2010 and 2013)
Show deleted items: Only non-deleted items

Incomplete messages: Hide

Search within attachments: Off

File info

P

5.2.1 Browsing mail store tree
Browse mode shows mail store in a tree-like structure and allows browsing folders and previewing individual

items.

This mode is best for navigating to specific mailboxes, folders and messages when it is precisely known what
data needs to be extracted.

For example, a user may ask to restore a specific message from a known folder. Expand his or her mailbox in
the tree, select the folder, find and click the item. All available properties and information about the item will be
displayed in the Preview window to the right of the tree.
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File  Options Help

= H .%d Search in Andy Kor

Browse
=-[8] ) Maibox Database edb [a]  Subject From To Created

Eg ?ne:r:]:ﬂ‘:\l’a'rt [11A § Initsnature, itis amitrary an...  Kyle Pakemman Andrew Wait; Richard; John; Dalia; Ro... Wednesday, 12 Mar 2014 17:2¢

g Dﬁ Andy Kort = It is my lady mother. | is my... Juliet Capulet Romeo Montague; Richard; Dalia; Mic... Wednesday, 12 Mar 2014 17:2¢
] Calendar (423) = Butthat it might not appeart... John Romeo Montague; Andy Kort; Robert ... Wednesday, 12 Mar 2014 17:2¢

[]2<] Contacts IEM} O= Do you persuade yoursefft...  Andy Kort Susane Tyler; Andy Kort; Juliet Capulet... Wednesday, 12 Mar 2014 17:2¢
[JC3 Deleted kems (24) = It wasall eloquence, and ge... Tim Goodler Dalia; Tim Goodler; Robert Rise; Susa... Wednesday, 12 Mar 2014 17:2¢
= ﬂ Alas, the heavy basketwhic... Alex Clark Dalia; Kyle Pakerman; Michael; Susan... Wednesday, 12 Mar 2014 17:2¢
Ojwr] Inbox (1,024) 3“ He went up a dark and narr... | Rudy Raid Brian; Michael; Richard; Dalia; Luise; T... | Wednesday, 12 Mar 2014 17:2]
Dj Joumal (27) = Noone, even there, could li... Romeo Montague  Brian; Alex Clark; Richard; Romeo Mon... Wednesday, 12 Mar 2014 17:2¢
&3 Junk Email (0} = Stephen Brice read the ne...  Luise Alex Clark; John; Tim Goodler; Michael... Wednesday, 12 Mar 2014 17:2¢
[T Notes (40) = Give me some light! Give m... Michael Romeo Montague; Richard; Andrew W... Wednesday, 12 Mar 2014 17:2¢
[C]C3 Outbox (0) = It were good, therefore that ... Andy Kort Romeo Montague; Andrew Wait; Kyle ... Wednesday, 12 Mar 2014 17:2¢
L1 Sent kems (0) [Ji= ] The riders could be heard)...  Andrew Wait Susane Tyler; Maria Woods; Romeo M... Wednesday, 12 Mar 2014 17:2¢
] 2 Tasks (47) 0= ﬂ The sinewand heart of man... Susane Tyler Brian; Juliet Capulet; Andy Kort; Robert... Wednesday, 12 Mar 2014 17:2
7-[] 55 Brian < >
o-[] 5 Dala {Fie went up a dark and narrow stair into alighted hall with shrouded windows
[ ]9 HealthMailboxadsSae Fe5b54860a1cf0218 B
H-[_] =) HealthMaiboxbaaB042e2601455a928ba55 || From: Rudy Raid v 3 attachment(s):
|| ESSAYS-6.txt, 1.00 KB
| ESSAYS-47tt, 1.10 KB

| ES5AYS-431t 231 KB

.. Joh
§E§ J:"; Capulet Sent  Wednesday, 12 Mar 2014 17:28:00 GMT
3..D§ Kyle Pakeman To: Erian; Michael; Richard; Dalia; Luise; Tim Goodler; Alex Clark; Kyle Pakerman...

H-[ ] Luise
]Dﬁ Maria Woods ere came a rain-sodden night when a mysterious message amived at
]Dﬁ Michael e little house in Olive Street. Both arwdsty and pride wers in Mrs.
- [] 59 Personal Archive - HealthMailbcradeSae e ice's eyes as they followed her son out of the door. At Tweffth

X L ) treet two men were lounging on the comers, each of whom glanced at
7-[] 59 Personal Archive - HealthMaiboxbaa8042e.  frim listessly as he passed. He went up a dark and namow stairinto a
JD@ Richard ighted hall with shrouded windows. Men with soberfaces were forming
]Dﬁ Robert Rise wifllina ~mtha czwdiet of tha flanre Tha | asdar wae thars aivdinn miltan

Preview | Properties

£
—
Completed Selected: 1 item(s) in 1 mailbox(es)

There is a check box next to the message. Check it to mark the message for export.
Continue to mark other items, folders and mailboxes for export in a similar way.

File  Options Help

= H .%d Search in Andy Kor

Browse
=-[m] gy Mailbox Database edb
-] 59 Alex Clark
- ]9 Andrew Wait
- (8] 55 Andy Kort
] Calendar (423)
[[] &a] Contacts (£4)
[ Deleted tems (24)

= oo (1026 |

.8 Joumal (27)

[ dunk Email (0)

[J.  MNotes (40)

[ Outbox (0)

[ Sert tems (0)

]+ Tasks (47)

i-[_]£9 Brian

1] Dalia

H-[_] =) HealthMailboxade 9ae FeSb54860a1cf0218
jDﬁ HealthMailboxbaa 80422 260143aa928ba55
1] John From: Tim Goodler

. Juliet Capulet
i Eg K;'e — Sent  Wednesday, March 12, 2014 10:28:00 AM UTC-07:00

]Dﬁ Luise To: Dalia; Tim Goodler, Robert Rise; Susane Tyler; Kyle Pakerman; Andrew Wait; Juliet Capulet; Romeo Montague...

7[5 Maria Woods Cc: “Dalia” <Dalia@no-such-email.com=, “Tim Goodler” <Tim.Goodler@no-such-email.com>, "Robert Rise...
-] Michael
7] Personal Archive - HealthMailboxade3ae e ' The Cure frowned and cortinued: "You look on yonder buming walls,”he
]Dﬁ Personal Archive - HealthMailboxbaa8042e.  said, 'and wonder when they will rise again on this hill made sacred
]Dﬁ Richard by the burial of your beloved, by the christening of your children, the

5[ ]9 Robert Rise w i which have aiven vou hapow homes. and the ts which
Preview ‘ Properties |

Subject From To Created

In itsnature., it is arbitrary an .. Kyle Pakerman Andrew Wait; Richard: John: Dalia; Ro... Wednesday, March 12, 2
It is my lady mother. #is my... Juliet Capulet Romeo Montague; Richard; Dalia; Mic... Wednesday, March 12, 2
Butthat it might not appeart... John Romeo Montague; Andy Kort; Robert ... Wednesday, March 12, 2
Do you persuade yourself ... Andy Kort Susane Tyler: Andy Kort: Juliet Capulet... Wednesday, March 12, 2
It wasall eloquence, and ge... Dalia; Tim Goodler; Robert Rise; Susa... |Wednesday, March 12, 3
Alas, the heavy basketwhic... Alex Clark Dalia; Kyle Pakeman; Michael; Susan... Wednesday, March 12, 2
He went up a dark and narr... Rudy Raid Brian; Michael; Richard; Dalia; Luise; T... Wednesday, March 12, 2
MNoone, eventhere, could li... Romeo Montague  Brian; Alex Clark; Richard; Romeo Mon... Wednesday, March 12, 2
Stephen Brice read the ne...  Luise Alex Clark; John; Tim Goodler; Michael... Wednesday, March 12, 2
Give me some light! Give m... Michael Romeo Montague; Richard; Andrew W... Wednesday, March 12, 2
It were good, therefore that ... Andy Kort Romeo Montague; Andrew Wait; Kyle ... Wednesday, March 12, 2
The riders could be heard ...  Andrew Wait Susane Tyler; Maria Woods; Romeo M... Wednesday, March 12, 2
The sinewand heart of man... Susane Tyler Brian; Juliet Capulet; Andy Kort; Robert... Wednesday, March 12,2 v
>

=&l &
=

3

mm&m&mmmﬁ&mmm%

REEEEEEE

= A

wasall eloquence. and generous and noble thought." It wasall x
v

£
Completed Selected: 1 folder(s} in 1 mailbox(es)

Use filtering feature for better browsing the list of items in a folder.
Enable filtering by pressing Ctrl+F keys. A special panel will appear in the right part of the program window.
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File  Options

L%H &

Browse

Help

Search in Andy Kort

=-[]4) Maibox Database edb
159 Aex Clark
[ ]&9 Andrew Wait
5[] Andy Kort
] Calendar (423)
[ 22] Contacts (44)
DE] Deleted hems (24)

DE:
j Joumal I_Z’}

[ dunk Email (0)

[T Notes (40)

[ Outbox (0)

[ Sert tems (0)

& Tasks (47)

1] 59 Brian

1] Dalia

[ ]9 HealthMailboxadsSae Fe5b54860a1cf0218
H-[_] =) HealthMailboxbaaB042e260145aa928ba55
1] John

H-[] 59 Juliet Capulet

i-[_]£9 Kyle Pakeman

H-[ ] Luise

H-[_] =9 Maria Woods

-] &9 Michael

H-[_] =) Personal Archive - HealthMailboxadeSae e
H-[_] =) Personal Archive - HealthMailboxbaa8042s:
o] Richard

-] = Robert Fise

£

Created
Wednesday, March 12, 2014
Wednesday, March 12, 201
‘Wednesday, March 12, 2014

From To

Tim Goodler
Juliet Capulet

[ Type g Subject

[] = {) Prvatebankersin Londong...
o =
W[ =

Romeo Montague; Alex Clank; Susane ...
Rudy Raid; Dalia; Romeo Montague; ...
Maria Woods; Susane Tyler; Andy Kort...

Schools have no exclusive..
3 relaxation in theexclu

priv | Where: All W [] Select fitered tems

<
This relaxation in theexclusive privileges of the company. is probably the principal...

From: Dalia v

Sent.  Wednesday, March 12, 2014 10:21:00 AM UTC-07:00
To: Maria Woods; Susane Tyler; Andy Kort; Robert Rise; Brian; Juliet Capulet

The Dutch settlements in the West, as well as those in the East Indies,
were orginally put under the govemment of an exclusive company. The
progress of some of them, therefore, though it has been considerable in
comparison with that of almost any country that has been long peopled
and established, has been languid and slow in comparison with that of

the greater part of new colonies. The colony of Surinam, though very
4, hla_ic otill infari, tha araztar nart of tha cunar

Preview ‘ Properties |

Completed

Use search in preview feature for quick find text in item preview.
Enable search in preview by pressing Ctrl+D keys after opening preview of item. A special panel will appear in
the right part of the program window.

File  Options

ﬁH &

Browse

Help

|Seart:h in Andy Kort

= ]ey Mailbox Database edb
0[] Aex Clark
L ]&9 Andrew Wait
5-[] 59 Andy Kort
] Calendar (423)
[ 22] Contacts (44)
DE] Deleted fems (24)

DEZ

.4 Joumal IZ’}

[ dunk Email (0)

[ Motes (40}

I3 Outbox (0)

[ Sert tems (0)

]+ Tasks (47)

i[9 Brian

1] Dalia

H-[_] =) HealthMailboxade 9ae FeSb54860a1cf0218
H-[_] =) HealthMailboxbaaB042e260145aa928ba55
i-[_]£9 John

H-[] 59 Juliet Capulet

H-[ ] =9 Kyle Pakeman

i-[]£9 Luise

H-[_] =9 Maria Woods

1[5 Michael

jDﬁ Personal Archive - HealthMailboxade 9ae e
H-[_] =) Personal Archive - HealthMailboxbaa8042s:
1[5 Richard

-1/ Robert Rise

£

 Subject

ﬂ In itsnature, it is arbitrary an...
It is my lady mother. Rt is my...
Butthat it might not appeart...
Do you persuade yourself t...
It wasall eloquence, and ge...
Alas, the heavy basketwhic...
He went up a dark and narr...
Moone, even there, could |i...
Stephen Brice read the ne...
Give me some light! Give m...
It were good, therefore that ...
The riders could be heard ...
The sinewand heart of man...

From To

Kyle Pakeman Andrew Watt; Ric
Juliet Capulet Romeo Montague
John Fomeo Montague
Andy Kort Susane Tyler; An
Tim Goodler Dalia; Tim Goodle
Alex Clark Dalia; Kyle Paken
Rudy Raid Brian; Michael; Fi
Romeo Mortague  Brian; Alex Clark;
Luise Alex Clark: John;
Andy Kort Romeo Montague
Andrew Wait Susane Tyler; Ma
Susane Tyler Brian; Juliet Capu v
>

A
X

i

Mo live servers connected.

Connect to a live server to enable
export of objects from source storage.

o DDDDDDDDDDDDD |
[L[L[LH[L[L[L[L[L[L[L[L[L

7 attachment(s):
|| ESSAYS-2.txt, .
|| ESSAYS-4.xt,
|| ESSAYS-10.txt
|| ESSAYS-43.4t

Fram: Michael

Sent.  Wednesday, March 12, 2014 10:2%:00 AM UTC...

To: "Romeo Montague™ <Romeo. Montague@no...

Ham. He poisons him i* th” garden for's estate. His name's Gonzago.
The story is extant, and written in very choice ltalian. You

chall era
Preview | Properties

£ > W

Completed

Tip
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Each individual item, folder and mailbox has a check box next to it. Using these check boxes, it is possible
to select as many or as few items for export as necessary.

To export an entire

e mail store, mark the root check box with the mail store name.

e mailbox, mark the check box next to mailbox in the tree.

o folder, expand a mailbox and mark the check box next to the desired folder.

5.2.2 Using search

The search in the main window provides the ability to search single or multiple mailboxes and perform actions
on the search results.

The best application of search mode is when the location and/or number of items to extract is not known
exactly. Using keyword search, it is possible to narrow down on specific messages, folders and mailboxes.
The quickest way to get search results is clicking on a particular mailbox, entering some keywords in the
Search field and clicking the button Start search.

Search results will be displayed on a separate tab.

Yy Axcient DirectRestore = B
File  Options  Help
u
y Search in user-defined locations: wait p
Browse | Search: awaits (377) X
[ Type Location g Subject From To 2
[0 B “Aex Cark\Calendar | would revenges, Andrew Wait Andrew Wait; Dalia; Susane Tyler; Mar..
[0 B “AlexClad\Calendar Fobert Rise Robert Rise; Romeo Montague; Brian; ..
[IC3 Deleted kems (16 [ Ed Aex Carkc\Calendar Michael Michael; Robert Rise; Romeo Montagu...
[ Inbox (625 o [0 B “AlexClad\Calendar Andy Kort Andy Kort; Dalia; Romeo Montague; Jo...
" [0 B “AlexClad\Calendar T will Andrew Wait Andrew Wait; Richard; Andy Kort; Tim ...
[ B Aex Clarkc\Calendar [Floulish] Romeo Montague Romeo Montague; Dalia; Richard; Mic...
[0 B “AlexClad\Calendar And under these Fobert Rise Robert Rise; Kyle Pakerman; Romeo ...
[0 B “AlexClad\Calendar High-stomach'd are they Dalia Dalia; Romeo Montague; Maria Woods...
[ B Aex Clarkc\Calendar If thou Brian Brian; Romeo Montague; John; Andre...
[0 B “AlexClad\Calendar Kyle Pakerman Kyle Pakeman; Alex Clark; Maria Woo. ..
[0 B “AlexClad\Calendar But as that Luise Luise; Dalia; Andrew Wait; Juliet Capul...
[0 B Aex Clark\Calendar "Rather Rudy Raid Rudy Raid; Alex Clark; Michael; Rome...
[0 B “Aex Cark\Calendar ﬂ Alex Clark Juliet Capulet; Tim Goodler; Michael; B...
[0 B “AlexClad\Calendar However thenigger got Luise Luise; Brian; Michael
[ B “Alex CladkCalendar Richard not John John; Richard; Susane Tyler; Maria W...
[0 B “Aex Cark\Calendar How Juliet Capulet Juliet Capulet; Andrew Wait; Alex Clark..
[0 B “Aex Cark\Calendar His head seemed Tim Goodler Tim Goodler; Susane Tyler; Kyle Paker...
[ B “Alex CladkCalendar Maria Woods Maria Woods; Alex Clark; Luise; Andre...
[0 B “Aex Cark\Calendar Juliet Capulet Juliet Capulet; Richard; Andrew Wait; ...
[0 B “AlexClad\Calendar But, good John John; Andy Kort; Susane Tyler, Robert ...
[ Ed  “AlexClark\Calendar Alex Clark Brian; Tim Goodler; Alex Clark; Luise; A...
[0 B “Aex Cark\Calendar you whoreson malt-horse Susane Tyler Susane Tyler; Romeo Montague; Luise...
[0 B “AlexClad\Calendar So frequently, the Society Fobert Rise Robert Rise; Andrew Wait; Kyle Paker...
] E AlexClad\Calendar Butthis Maria Woods Maria Woods; Romeo Mortague w
£ >
| Page 1 0f10| [ 100 | messages per page
Search complete, 977 matches

If a user knows exactly in what mailbox or folder the data is located, using Search in mailbox option will
speed up the search.
Right-click on a folder/a mailbox will open a context menu.
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X

File  Options Help

u
i I:lﬁﬂ o Select mailboxes orfolders to search

Browse
= ]ey Mailbox Database edb
159 Aex Clark

-9 Andrew Wait C:\Exchange Server Database\Mailbox Database.edb
D 25 Bian Size: 904 Mb

Mailbox Database.edb

&2 Dl Date: 3/13/2014
12-1 59 HealthMaiboxadeSas Fe5b54860a1ci0218267 Version: Exchange Server 2013
Dﬁ HealthMailboxbaa 80422 2601452292 8ba554el

Transaction logs not used.

Search in mailbox

22 mailboxes. Select a mailbox to display folders.
Collapse all mailboxes Load time: 00:00:03
Clear all selections

Display time: GMT
]9 Personal Archive - HealthMailboxadeSae eb! PST encoding: Unicode (Microsoft Outlook 2003, 2007, 2010 and 2013)
-] 29 Persanal Archive - HealthMailboxbaa8042:260 Show deleted items: Only non-deleted items
-] 9 Richard Incomplete messages: Hide
&-[]59 Robert Rise Search within attachments: Off
-] Romeo Montague
- ]9 Rudy Raid
(-] £9 Susane Tyler
-] 59 SystemMaiboxfads9ae F-e505-4860-a 1cf-021
-] &9 Tim Goodler

( File info |

Completed

By clicking on this menu advanced mode of search dialog will be opened and Search in field will be filled with

the selected mailbox/folder.

Fill in necessary search parameters and start the search.

For more precise searches click on the Search field, drop-down list of all search fields will appear:

e Search in - specifies mailbox(es)\folder(s) to search in. Default: entire database. If you select one or more
Search in check boxes, but specify no additional search criteria, the utility will return all items from the
selected folder(s).
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=0
-] Mex Clark
D@ Andrew Wait
2[99 Andy Kort
E@ Brian
[]24 Calendar (444}
4] Contacts (44)

C]Eg Junk Email (0)

[ Motes (40}

C]Eg Outbox (0)

C]cg Sent hems (0)

[ Tasks (47)

-[]&9 Dalia

D@ HealthMailboxade9ae Febb 54860 1021826768750
D@ HealthMailboxbaa 80422 26014%a5928babb4a 0054742
-] &9 John

-] 59 Juliet Capulet

-] Kyle Pakeman

59 Luise

-] 59 Maria Woods

(]2 Michael

[ 145 Personal Archive - Health Mailboxade Sae Fe 5548602 1cF021826768730

[ ] Include mailboxes that are expanded. have items selected or were searched before

=]

OK || Cancel

e Has words - search for mail store items that have words or phrases entered in the field.

e Doesn't have - search for items that do not have words or phrases entered in the field.

¢ Has attachments - search for items with attachments.

e From - search for keywords in the From: field.

e To - search for keywords in the To: field.

Subject - search for keywords in subject.

o Date range - set specific date range if known. It is obligatory to set both the beginning and the end of the
desired time period.

The outcomes of a search can be:

1. The program was able to find items (1) that corresponds to specified search parameters (2). The user can

select separate items or mark search results for recovery.
Clicking an item in the search results tab will open the item preview. Selecting item(s) in search results will
make their recovery possible.
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File

Options  Help

Eeart:h in user-defined locations: from:(Andrew) has attachment wait

o

Searchin...

159 Andrew Wit (43)
[ Calendar (25)
[ Inbox (18)
ﬁ Andy Kort (15)
e Inbox (19)

[1£9 Brian (14)

L[] Inbox (14)

Location

“Andy KortInbox
“WAlex ClarkInbox
“WAndrew Wait'\Inbox
“Brian“Inbox

“WAndy Kort'Inbox
“WAndy Kort'Inbox
“Andrew Wait Inbox
“WAlex ClarkInbox
“WAndrew Wait'\Inbox
e Clarknbaox
“Brian‘Inbox

“WAlex ClarkInbox
e Clarknbaox

Has words:

Doesnt have:

Alex Clark; Andrew Wait; Andy Kort; Brian

Include mailboxes that are expanded, have items selected or were
searched before

[] Find whole words only

|wa'rt

|

Has attachments
|ﬂndrew

“WAndy Kort'Inbox
“WAndy Kort'Inbox
“Andrew Wait*Inbox
“WAlex ClarkInbox

“WAndrew Wait'\Inbox
“Andy KortInbax
“WAndy Kort'Inbox
“WAndrew Wait'\Inbox
“Andrew Wait'Inbosx
“WAlex ClarkInbox
“Brian‘Inbox

o o o o
|[ZJ&&&&&&&&&&&&&&&&&&&&&&&%

=

4 |Page‘|of‘|| L & ]

Alone she was in thehouse—her brother...
Alone she was in thehouse—her brother...
Dan still owns it. Dan still owns it. Dan ...
Dan still owns it. Dan still owns it. Dan ...
Dan still owns it. Dan still owns it. Dan ...

Andy Kort; Romeo Montague; Mic
Kyle Pakeman; John; Susane Tyl
Kyle Pakeman; John; Susane Tyl
Robert Rise; John; Kyle Pakemar
Robert Rise; John; Kyle Pakemar
Robert Rise: John; Kyle Pakenniar .,

>

Andrew Wait
Andrew Wait
Andrew Wait
Andrew Wait
Andrew Wait
Andrew Wait

Search complete, 96 matches

100 | messages per page

‘Find whole word only’ is not enabled by default. This option can be changed in the search parameters. When
‘Find whole words only’ option is selected an exact match search will be performed.

File

~~

I

Browse

£

BD .’
glf=

[

Options

R

Help

(-._u}

Select mailboxes orfolders to search:

Mailbox Database.edb

[[]£9 HealthMailboxadeSae Fe5b54860a 1cf0218267
[[]£9 HealthMailboxbaad042=260149a39280a554e(
[1£9 John

[]59 Juliet Capulet

[]£9 Kyle Pakeman

[ Luise

159 Maria Woods

159 Michae!

[[]£§ Personal Archive - HealthMailboxade 9ae FeSb
[1£9 Personal Archive - HealthMailboxbaaB8042e 260
[ Richard

[]5) Robert Rise

[]£9 Romea Montague

]9 Rudy Raid

[[]£9 Susane Tyler

Dﬁ SystemMailbox{adeSae F-2505-4860-a 1cf-021
]9 Tim Goodler

Mailbox Database.edb

C:\Exchange Server Database\Mailbor
Size: 904 Mb

Date: 3/13/2014

Version: Exchange Server 2013

Transaction logs not used.

22 mailboxes. Select a mailbox to dis|
Load time: 00:00:03

Display time: Local

PST encoding: Unicode (Microsoft Ou
Show deleted items: Only non-deletes
Incomplete messages: Hide

Search within attachments: Off

Searchin

‘ Find whole words onfy .

Select mailboxes or folders to search

Include mailboxes that are expanded, have items selected or were

searched before

Has words:

Doesnt have:

To:
Subject:

Date range:

[] Has attachments

File info |

Completed

Counters of found elements are automatically updated or can be updated manually by clicking on the Refresh
button. If any folder is selected and the program has found new elements in it, then the following value will be
shown: previous(value, when we selected the folder) value of a counter + count(in green) of newly found
elements, which will be updated in real-time.
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File  Options Help

Search in user-defined locations: wait

Location Subject From To
e Clarknbox John Richard; Andrew Wait; Ru
“Alex ClarkInbox Do not write to me, but know that f Ico... Susane Tyler Rudy Raid; Juliet Capulst;
e Clarknbox It is to these seadochs that the hemings... Mara Woods Dalia; Rudy Raid; Tim Goc
“Alex Clarnbox The crowds liked best to go toCompta...  John Andrew Wait; Andy Kort; E
e Clarknbox Presently hebent over and put his big h... Andrew Wait Richard; Brian; Romeo Mo
e Clarknbox It sometimes happens, indeed, that the...  Andrew Wait Dalia; Alex Clark; Susans
“Alex Clarknbox "Energy and ill temper," some say, "are... Michael Juliet Capulet; Susane Ty
“WAlex ClarkInbox WESTMORELAND. WESTMORELAN... Andrew Wait Kyle Pakeman; Andy Kort
e Clarknbox lt was easyto him. | was Susane Tyler Andrew Wait; Robert Rise
“Alex Clarkhnbox From the 25th of Edward lIl. Fromthe ... Andrew Wait Susane Tyler; Michael; Ky
“WAlex ClarkInbox Labour is there so well rewarded, thata... John Robert Rise; Michael; And
e Clarknbox Would you'd pardon me. Would you'd ... Brian Romeo Montague; Kyle F:
“WAlex ClarkInbox DUKE. DUKE. DUKE. DUKE. DUK.. Andrew Wait Rudy Raid; Brian; Alex Cla
e Clarknbox MRS. MRS. MRS Alex Clark Andrew Wait; Andy Kort; £
e Clarknbox The face is Fudy Raid Michael; Juliet Capulet; Ky
“Alex Clarhnbox But the thing Andrew Wait Susane Tyler; Alex Clark; |
“WAlex ClarkInbox When the Brian Andrew Wait
“Alex ClarkInbox | have Andrew Wait Andy Kort; Maria Woods; .
“Hlexe Clarknbox Maria Woods John; Alex Clark; Susane
“WAlex ClarkInbox He had taken Andrew Wait John; Andrew Wait; Michz
“WAlex Clark\Deleted fems THERSITES. Alex Clark Andy Kort; Juligt Capulet; |
“Hlexe Clarknbox LADY FAULCOMBRIDGE. John AMlex Clark; Maria Woods; .
“WAlex ClarkInbox Dalia Brian; Robert Rise; Michat
“WAlex ClarkInbox After Andrew Wait Juliet Capulet; Luise: John ,
>

4 |Page 1Tofd | b M O masagsperpage

] Calendar (274)
----- [ 24] Cortacts (1)
..... [ Deleted tems (15)
..... D] Inbox (525)
----- ]+ Tasks (1)
[—],:lﬁ Andrew Wait (1,460)
..... Tz Calencar (421)
..... [ Deleted tems (25)
..... D] Inbox (1,008)
----- .4 Joumal (1)
----- [ Mates (2)
----- ]+ Tasks (2)
2175 Andy Kort (343)
..... ] Calendar (275)
..... [ Deleted ttems (15)
..... [IEm Inbox (546}
----- ] & Joumal (2)
----- [ Mates (3}
5[] Brian (920)
..... T Calencar (272)
----- [ 22] Cortacts (3)
..... [ Deleted tems (14)
..... [ Inbox (540
----- ]+ Tasks (1)

= AOO0000000000000000000000 O
EEEEEEEEEEN NN BN NEEEEE §

Search complete, 4,310 matches

Words and phrases which match the search query are highlighted in the preview, which helps to easily identify
where the match was found.

File  Options Help

p [ Search in user-defined locations: from:(Andrew Wait) wait
7 rjl. =

Browse | Search: «from:{Andrew Wait) waits (109) X |
[SRMLS ) Search: «from:(Andrew Wait) waits (109)
B[ &9 Andrew Wait (109)

Location Subject From To
“Andrew WaitInbox Will it not be received.  When we hav_. Andrew Wait  Juliet Capulet; Andrew Wait;
“Andrew Wait Inbox: Exeunt FAIRIES Exeurt FAIRIES Andrew Wait  Maria Woods; Juliet Capulet;
“Andrew Wait Inbox: Conceming the bounds of unity; the tu... Andrew Wait  Alex Clark; Andrew Wait; Lui:
“Andrew Wait Inbox Andrew Wait  Andy Kort: Romeo Montague
“Andrew Wait Inbox: A particular courtry, in the same Andrew Wait  Robert Rise; Andrew Wait; A
“Andrew Wait Inbox: They were getting kind of interested. T... Andrew Wait  Rudy Raid; Andrew Wait; Ro
“Andrew Wait Inbox In this action it isgenius; not the privileg... Andrew Wait  John; Kyle Pakeman; Rome:
“WAndrew Wait'\Inbox SHALLOW. SHALLOW. SHALLO.. Andew Wait  Alex Clark; Juliet Capulet; Lui
“WAndrew Wait'\Inbox Thesubscribers to a new loan, who me... Andrew Wait  Robert Rise; Maria Woods; L
\ [ Taon Wk |- et ien: Sserd
“WAndrew Wait'\Inbox Let it be vituous to be obstinate. Lett ~ Andrew Wait  Alex Clark; Andrew Wait; Lui:
“Andrew Wait Inbox: Hisgaments hung in tatters; his boots ...  Andrew Wait  Kyle Pakerman; Maria Wood

i

[Eg Inbex (26)

&&H&&&&&&&&&

|
|
d
d
|
d
d
|
d
|
W
d
|
<]

& attachment(s):
[aZ]DR.gif, 275 KB

[ DRSPgif, 23.7 KB

[ DRSPgif, 23.7 KB

|| ESSAYS-3it, 1.93 KB

Whether taxes upon the necessaries of life, such as those in Great || ESSAYS-10.txt, 1.20 KB
Britain upon soap, salt, leather, candles, etc. necessarily raise the [ ESSAYS-11.t¢t, 161 KB
rice of lah A ndities_| shall B

H 4 |Page 1 of2| B0 masagsperpage

12 Mar 2014 17:25:00 GMT
John; Michael; Luise; Susane Tyler; Rudy Raid; Romeo Montague; Juliet Capulet...

“John” <John@no-such-email.com?, "Michael” <Michael@nco-such-email.com...

Search complete, 109 matches

2. The search didn't match any items. Review search parameters and run another search.
To delete temporary data, generated by Axcient DirectRestore, go to the File menu and click Delete saved
search indexes and logs.
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File | Options Help

Open file... Ctrl+ O

Recent

Search in user-defined locations: wait

Close file

Reload database using transaction logs

—

Location Subject From To

“Alex Clarnbox Brice to leave, and twenty times, by th... Maria Woods Andrew Wait; Andy Kort; E
e Clarknbox And for @ woman wert thou first create...  Dalia Luise; Rudy Raid; John; M
“Alex ClarkInbox ﬂ And as with religion amongst us at that ... Andrew Wait Andy Kort; Maria Woods; .
“Alex Clarnbox Open wagons and conestogas and car... John John; Dalia; Luise; Susane
“Alex ClarkInbox ‘When the war came, their system conti... Andrew Wait Brian; Alex Clark; Andy Ko
e Clarknbox But since she pricked thee out for wom... Rudy Raid Michael; Robert Rise; Rict
“Alex Clarknbox It is & distinction of species. lisa Andy Kort Michael; Robert Rise; Rict
“WAlex ClarkInbox It called from the far north—the northof ... Tim Goodler Luise
e Clarknbox lt was, besides, a foreign manufacture,...  Andrew Wait Romeo Montague; Daliz; |
“Alex Clarkhnbox Then, again, a poet or poem may coun... Rudy Raid Andrew Wait; Maria Wooc
e Clarknbox | can give youenough for any woman's... Maria Woods Tim Goodler; Maria Wood:
e Clarknbox Past cure | am, now reason is past car... Dalia Brian; Tim Goodler; Alex C
“Alex Clarkhnbox That members of the laboring class, at ... Andrew Wait Andrew Wait; Tim Goodler
e Clarknbox The Motary was sound asleepin his ar...  Kyle Pakerman Brian; Rudy Raid; Dalia
“WAlex ClarkInbox John Richard; Andrew Wait; Ru
“Alex Clark\nbeox Do not write to me, but know that  lco... Susane Tyler Rudy Raid; Juliet Capulet;
e Clarknbox It is to these seadochs that the hemings... Mara Woods Dalia; Rudy Raid; Tim Goc
e Clarknbox The crowds liked best to go toCompto... John Andrew Wait; Andy Kort; E
“Alex Clarknbox Presently hebent over and put his big h... Andrew Wait Richard; Brian; Romeo Mo
e Clarknbox It sometimes happens, indeed, that the...  Andrew Wait Dalia; Alex Clark; Susans
e Clarknbox "Energy and il temper,"” some say, "are... Michael Juliet Capulet; Susane Tyh
“WAlex ClarkInbax WESTMORELAND. WESTMORELAN... Andrew Wait Kyle Pakeman; Andy Kort
e Clarknbox lt was easyto him. | was Susane Tyler Andrew Wait; Robert Rise
e Clarknbox From the 25th of Edward Ill.  From the ... Andrew Wait Susane Tyler; Michael; Ky
>

4 (Page 1 ofd*| b bl O messagesperpage

Search for files to open...

Export selected itemns into PST... Ctrl+S
Export into original Exchange mailbox...  Ctrl+G

Cancel current operation Ctrl+N

Open log folder

! Belete sa\.rea temp !IIS and logs

[ Deleted ttems (15)
[ Inbox (546)
] & Joumal (2)

; [ Mates (3}
5[] Brian (920)

T Calencar (272)
[ 22] Cortacts (3)
[ Deleted tems (14)
[ Inbox (540
]+ Tasks (1)

ype
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=]
=
=
=
=
=
=
=
=

d
d
|
d
d
|
d
d
|
d
d
|
d
|
<

-

Search complete, 4,310 matches

Note
Next search in the same folder/mailbox will be almost instant (only if saved search indexes and logs haven't
just been deleted).

Note
Search with empty query is not available.

Note
Asterisk (*') is added to all words in search fields by default. This allows to find not only specified words but
also their word forms. Use ‘Find whole word only’ option or quotes (" ") to search for an exact phrase.
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Advanced search
Advanced search uses symbols and operators in queries. These operators allow you to find what you're looking
for quickly and accurately.
To use advanced search enter operators and their values into the Search field (1).

File

&

£

Options  Help

-] 59 Andrew Wit

-5 Andy Kort

-] 59 Brian

&-[]59 Dalia

Dﬁ HealthMailboxadeJae Febb54860a1cf 0218267
(-] £ HealthMailboxbaa 80422 2601452a9280a554e
E-[JE&9 John

[-[ ]9 Juliet Capulet

-] £9 Kyle Pakeman

- JE Luise

-] 59 Maria Woods

[-[] &5 Michael

Dﬁ Personal Archive - HealthMailboxade Sae Febb!
[#-[_]£9 Personal Archive - HealthMailboxbaaB042 260
-] 59 Fichard

Dﬁ Robert Rise

-] Romeo Montague

&[] &9 Rudy Raid

(-] £9 Susane Tyler

-] SystemMaibox{adeSae 750548602 1c-021¢
Dﬁ Tim Goodler

Completed

Operators are listed below:

E’e_led mailboxes orfolders to search: from:"alex" subject:"follow™

Mailbox Database.edb

C:\Exchange Server Database\Mailbox Database.edb
Size: 904 Mb

Date: 3/13/2014

Version: Exchange Server 2013

Transaction logs not used.

22 mailboxes. Select a mailbox to display folders.
Load time: 00:00:03

Display time: Local

PST encoding: Unicode (Microsoft Outlook 2003, 2007, 2010 and 2013)
Show deleted items: Only non-deleted items

Incomplete messages: Hide

Search within attachments: Off

File info

Operator Definition Example

from: Used to specify the sender. Example: from:alex
Meaning: messages from Alex.

to: Used to specify a recipient. Example: to:John
Meaning: all messages that were sent to
John (by any user).

subject: Search for words in the subject Example: subject:dinner

line. Meaning: messages that have the word

"dinner" in the subject.

OR Search for messages matching Example: from:alex OR from:john

term A or term B.
OR must be in all caps

Meaning: messages from Alex or from
John.

AND or Space

Search for messages matching
term A and term B.
AND must be in all caps.

Example: from:alex AND from:john
Meaning: messages from Alex and from
John.

(hyphen)

Used to exclude messages from
your search.

Example: dinner -movie

Meaning: messages that contain the word
"dinner" but do not contain the word
"movie".
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Operator

has:attachment

att_name:

cc:
bcc:

(quotes)

create_time:[yyyymmdd
yyyymmdd]

after:
before:
older:
newer:

older_than:
newer_than:

Definition

Search for messages with an
attachment.

Search for messages with specified
attachment name.

Used to specify recipients in the
cc: or bece: fields

Search on bce: cannot retrieve
messages on which you were blind
carbon copied.

Used to search for an exact
phrase*

*capitalization isn't taken into
consideration.

Used to group words
Used to specify terms that
shouldn't be excluded.

Search for messages created
during a certain period of time.

Search for messages sent or
received during a certain period of
time

(using the date format yyyymmdd).

Similar to older and newer, but
allows relative dates using d, m,
and y for day, month, and year.

Example

Example: from:john has:attachment
Meaning: messages from John that have
an attachment.

Example: to:jane att_name:photo.png
Meaning: messages to Jane that have an
attachment with specified attachment
name.

Example: cc:John
Meaning: messages that were cc-ed to
John.

Example: "i'm feeling lucky"
Meaning: messages containing the phrase
"i'm feeling lucky" or "I'm feeling lucky".

Example: subject:"dinner and a movie"
Meaning: messages containing the phrase
"dinner and a movie" in the subject.

Example: from:alex (dinner OR movie)
Meaning: messages from Alex that
contain either the word "dinner" or the
word "movie".

Example: subject:(dinner movie)
Meaning: messages in which the subject
contains both the word "dinner" and the
word "movie".

Example: create_time:[20110416
20110516]

Meaning: messages created between
April 16, 2011 and May 16, 2011.

Example: after:20110416
before:20110516

Meaning: messages sent between April
16, 2011 and May 16, 2011.

More precisely: messages sent after
12:00 AM (or 00:00) April 16, 2011 and
before May 16, 2011.

Example: newer_than:2d
Meaning: finds messages sent within the
last two days.
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Operator Definition Example
size: Search for messages larger than Example: size:300
the specified size in bytes. Meaning: messages larger than 300 bytes

Abbreviations for numbers (B, K, M)

are allowed. Size limit is 2000MB. | Example: size:[300 2000]
Meaning: messages larger than 300 bytes
but smaller than 2000 bytes.

larger: Similar to size, allows abbreviations || Example: larger:1M
smaller: for numbers (B, K, M). Size limit is | Meaning: All messages of at least 1MB in
2000MB. size.

Example: larger:150K smaller:1M
Meaning: messages larger than 150KB
but smaller than 1MB.

+ Match the search term exactly. Example: +movie
(plus sign) Meaning: minds messages containing
“movie” but not “movies” or “movei”.

Using wildcard characters

A wildcard character is a keyboard character such as an asterisk (*) or a question mark (?) that is used to
represent one or more characters when you are searching for files, folders, printers, computers, or people.

Wildcard characters are often used in place of one or more characters when you do not know what the real
character is or you do not want to type the entire name.

Wildcard character Definition Example

* Used to substitute for zero or more || Example: subject:d*g

(asterisk) characters. Meaning: finds messages containing
words "doing", "dog", "debug", etc.

? Used to substitute for a single Example: subject:d?g

(question mark) character in a name. Meaning: finds messages containing

words "dog", "dig", "dug", etc.

Note
Use checked 'Find whole word only' in case using question mark ("?") in the start of the word.

Note
Other special characters are not used for search. Search query, containing special characters, may return
incorrect results.
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Search within attachments

Search within attachments is not enabled by default. This option can be changed in the Options menu.

This option allows to perform search in attachments’ content.

r Axcient DirectRestore = =

File | Options | Help

Y Show mailbox mismatch warning in expert mode

LA « | Show delete folder warning in expert mode Select mailboxes orfolders to search ,0
Show notification panel
E
ETT_;"‘I Show progress dialog
Allow connections to live servers atabase.edb
Seacchauttip atiachment= e Server Database\Mailbox Database.edb
5]
H : b
3| PST encodin
’ /2014
Incomplete messages 3 change Server 2013
Show deleted items 3
Display time y Inlogs not used.
Updates > . .
- P es. Select a mailbox to display folders.
&[5 Luise Load time: 00:00:03
-] 59 Maria Woods
-] 55 Michael Display time: GMT

--D:J Personal Archive - HealthMailboxadeae #eSb! PST encoding: Unicode (Microsoft Outlook 2003, 2007, 2010 and 2013)
(-] 59 Personal Archive - HealthMailboxbaa8042e 260 Show deleted items: Only non-deleted items

e[ ]9 Richard Incomplete messages: Hide

-5 Robert Rise Search within attachments: Off

-] £ Romeo Mantague

- ]&9 Rudy Raid

-] Susane Tyler

DH SystemMailbox {ade Sae F-e505-4860-a 1cf-021¢

-] &9 Tim Goodler

< > File info

Completed

Note
After enabling this option the database will have to be reopened. Search process may take longer when
search within attachments is enabled.

5.3 Exporting items

Axcient DirectRestore includes the injection capability for items (emails, calendars, contacts, etc.) from offline
database and PST/OST files to original live Exchange databases as well as granular data extraction to
Personal Storage File (.pst) files.

5.3.1 Restore to original live Exchange Server. Standard mode

Important Note

Standard export mode requires access to Active Directory to establish connection to Exchange Server.
The program requests users list from Active Directory and checks if IDs of offline and live user mailboxes
match. That's why the user, logged in, must be a domain user.

After startup, opening an EDB file and checking items the main window of the application looks as follows:
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File  Options

=

J Browse |

Help

Search in Alex Clark

= ]ey Mailbox Database edb
BD@ Alex Clark

]2 Calendar (422)

[ 2] Contacts (45)

(] Outbex (0)

[ Sert tems (0)

[1 & Tasks (48)

H-[ ] 59 Andrew Wait

0[50 Andy Kort

H-[_] 59 Brian

1] Dalia

[ ]9 HealthMailboxadsSae Fe5b54860a1cf0218
H-[_] =) HealthMailboxbaaB042e260145aa928ba55

1] John

i-[_]£9 Kyle Pakeman
H-[ ] Luise
H-[_] =9 Maria Woods
o159 Michael

0

0

[ttt Y o Y [ Yoy oY o Y [4mmt iy =

Subject

She was glad that Jo shoul...

In itsnature, it is arbitrary an...
It is my lady mother. 1 is my...
Butthat it might not appeart...
Do you persuade yourself t...

| regret that | am unable tor...
Mlas, the heavy basketwhic...
He went up a dark and narr...
Noone, even there, could li...
One of the things particular...
Stephen Brice read the ne...

Give me some light! Give m...
His condition leaves him no...
.. Maria Woods

What a pied ninny’s this!

*Your vows, your memories, ...
The riders could be heard ...
The sinewand heart of man...
Now, herald, are the dead ...
Dieu vous garde, monsiewr....
If you had seen the look in ...
She wore a gray blouse wit..
But though the public scho...
if twas in gold; but at the sa...

From

Luise

Kyle Pakeman
Juliet Capulet
John

Andy Kort
Brian

Alex Clark
Rudy Raid
Romeo Mortague
Robert Rise
Luise

Michael

Juliet Capulet

John

Andrew Wait
Susane Tyler
Alex Clark
Michael

Romeo Mortague
Robert Rise

Luise

Andrew Wait

To

Maria Woods; Kyle Pakeman; Luise; ...

Andrew Wait; Richard; John; Dalia; Ro...
Romeo Montague; Richard; Dalia; Mic...
Romeo Montague; Andy Kort; Robert ...

Susane Tyler; Andy Kort; Juliet Capulet...
John; Brian; Tim Goodler; Kyle Pakem...
Dalia; Kyle Pakeman; Michael; Susan...

Brian; Michael; Richard; Dalia; Luise; T...
Brian; Alex Clark; Richard; Romeo Mon...

John; Maria Woods: Richard; Alex Clar...
Alex Clark; John; Tim Goodler; Michael...

Romeo Montague; Richard; Andrew W...

Romeo Montague; Richard; Juliet Cap...
Maria Woods; Brian; Juliet Capulet; Ro...
Robert Rise; Maria Woods; Andrew W...
Susane Tyler; Maria Woods; Romeo M...
Brian; Juliet Capulet; Andy Kort; Robert..
Michael; Alex Clark; Susane Tyler; Ro...

Maria Woods; Robert Rise

Dalia; Juliet Capulet; Alex Clark; Rome...

Alex Clark; Susane Tyler; Maria Woods...

John; Brian; Michael; Andy Kort; Maria ...
Rudy Raid: Juliet Capulet; Brian; Andy ...

Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2

H-[_] =) Personal Archive - HealthMailboxadeSae e
H-[_] =) Personal Archive - HealthMailboxbaa8042s:
o[]S Richard

-] = Robert Fise

My stars shine darkdy over ...
Charey was of these peopl...

Rudy Raid
Romeo Montague
Richard

Juliet Capulet; Tim Goodler; Alex Clark;...
Susane Tyler; Alex Clark; Michael; Rud...
Richard; John; Andy Kort; Robert Rise;...

Wednesday, March 12, 2
Wednesday, March 12, 2

Wednesday, March 12,2 ¥
>

[Z..[L[L[L[L[L[L[L&[L[L[L[L&[L[L&&[L&&[L&[L[L&5;

[
[
[
[
[
[
[
[-[ ]9 Juliet Capulet
[E
[
[
[
[
[
[
[E

~O00000O00O0O00O0OooOooooOdooooo o

£

Completed

Clicking the injection button will bring up the following dialog:

Host (ex.: contoso.com or 152.168.0.5): About export into original mailbox

| ES2013 no-such-email.com

v | Refresh || Advanced.. Selected items will be copied from
offline mailboxes into their original

locations on live Exchange Server.

Details:
Export from source mailbox "Alex Clark” to destination mailbox Alex . Clark @no-such-email.com: 4 items.

The destination Exchange Server is
detected automatically using the
current Active Directory domain.
Current user should be @ member
of the same domain as target
Exchange Server and should have

Exchange impersonation access to
destination mailboxes.

Each selected item will go toits
original location in respective
mailbox, e.g. Patrick’s offline mail
will go to Patnick’s mailbox, Lisa's
calendar items to Lisa's mailbox
etc. When selected items cannot be
matched to destination mailboe,
they will not be exported.

[ Unselect successfully exported items

Domain name of the machine with Exchange Server will be automatically detected if current machine is in the
same domain with Exchange Server. Otherwise, the host will not be detected and has to be entered manually.
By default, Axcient DirectRestore uses current user to establish the connection. If current user doesn't have
rights to impersonate selected for export user, an appropriate error will appear in details.
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In case of error it is recommended to use the Advanced button and configure the connection settings.

Host jex.: contoso.com or 152.168.0.5):

- Exchange impersonation lets you connect to
| LI ment WWind credential :
s& e neows el a mailbox ather than the default one for your

credentials. To use the feature, access
User logon name {ex.: user1): permissions need to be configured at
Exchange Server.

Save password

There are two ways to connect to selected mailbox:
1. Use credentials of selected mailbox.

2. Specify the user that has impersonation rights.
To use credential of selected mailbox, enter host name of machine with Client Access Role, unmark Use
current Windows credentials enter user name and password and press Connect.

Host (ex.: contoso.com or 1592.168.0.5):
| E52013 nosuch-email com

- Exchange impersonation lets you connect to
1 ment Wind credential -
[ Use e neows a8 a mailbox ather than the default one for your
credentials. To use the feature, access
User logon name {ex.: user1): permissions need to be configured at

|Nex_|:|a|-k Exchange Server.

Password:

|

[ ] Save password

To use Exchange impersonation to establish the connection, enter host name of machine with Client
Access role, unmark Use current Windows credentials, enter credentials of the user with impersonation
rights and press Connect. In the example below Brian has impersonation rights to access Dalia's mailbox.
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Host {ex.: contoso .com ar 192.168.0.5):

| ES2013 nosuch-email com

[] Use cument Windows credentials

|User logon name (ex.: userl):

| Brian

Passward:

|

[] Save password

Exchange impersonation lets you connect to

a mailbox other than the default one for your
credentials. To use the feature, access
permissions need to be configured at
Exchange Server.

Exporting to live Exchange is also available via the File menu.

File | Options

Open file...

Help

Recent
Close file

Reload database using transaction logs

Search in Alex Clark

—

DN ENNENENNNEENNENENONEE §

Search for files to open...

Export selected itemns into PST... Ctrl+S
trl+

Ctrl+N

port into original nge mailbox...

Cancel current operation

Open log folder

Delete saved temp files and logs

Exit

T oy

13 Tasks (48)

-] 59 Andrew Wit
-] 55 Andy Kot
-[_]£&9 Brian
&[5 Dalia
[-[_]£9 HealthMailboxadsSas Fe5b54860a1cf0218
-[ ]9 HealthMaiboxbaad(42e 260149aa328ba55
-] &9 John

[-[ ]9 Juliet Capulet
- [J£9 Kyle Pakeman
&[5 Luise
-] 59 Maria Woods
-[JE9 Michael

[} Dﬁ Personal Archive - HealthMailboxade Sae Fe
[#-[_]£9 Personal Archive - HealthMailboxbaaB042e.
-] &9 Richard

[ £§ Robert Rise

*RERREREREERE R EEEE S

£

[ Y Y o [T} =

Subject
She was glad that Jo shoul

In itsnature, it is arbitrary an...
It is my lady mother. 1 is my...
Butthat it might not appeart...

Do you persuade yourself t...

| regret that | am unable tor...
Alas, the heavy basketwhic...
He went up a dark and narr...
Noone, even there, could li...
One of the things particular...

Stephen Brice read the ne...

Give me some light! Give m...
His condition leaves him no...
. Maria Woods

What a pied ninny’s this!

*Your vows, your memories, ...

The riders could be heard ...

The sinewand heart of man...

Now, herald, are the dead ...

Dieu vous garde, monsiewr....
If you had seen the look in ...

She wore a gray blouse wit..
But though the public scho...

if twas in gold; but at the sa...

My stars shine darkdy over ...
Charley was of these peopl...

From

Luise

Kyle Pakeman
Juliet Capulet
John

Andy Kort
Brian

Alex Clark
Rudy Raid
Romeo Mortague
Robert Rise
Luise

Michael

Juliet Capulet

John

Andrew Wait
Susane Tyler
Alex Clark
Michael

Romeo Mortague
Robert Rise

Luise

Andrew Wait
Rudy Raid
Romeo Mortague
Richard

To

Maria Woods: Kyle Pakeman: Luise;

Andrew Wait; Richard; John; Dalia; Ro...
Romeo Montague; Richard; Dalia; Mic...
Romeo Montague: Andy Kort: Robert ...
Susane Tyler; Andy Kort; Juliet Capulet...
John; Brian; Tim Goodler; Kyle Pakem...
Dalia; Kyle Pakeman; Michael; Susan...

Brian; Michael; Richard; Dalia; Luise; T...
Brian; Alex Clark; Richard; Romeo Mon...

John; Maria Woods; Richard; Alex Clar...
Alex Clark; John; Tim Goodler; Michael...

Romeo Montague; Richard; Andrew W...

Romeo Montague; Richard; Juliet Cap...
Maria Woods; Brian; Juliet Capulet; Ro...
Robert Rise; Maria Woods; Andrew W...
Susane Tyler; Maria Woods; Romeo M...
Brian; Juliet Capulet; Andy Kort; Robert..
Michael; Alex Clark; Susane Tyler; Ro...

Maria Woods; Robert Rise

Dalia; Juliet Capulet; Alex Clark; Rome...

Alex Clark; Susane Tyler; Maria Woods...
John; Brian; Michael; Andy Kort; Maria ...
Rudy Raid: Juliet Capulet; Brian; Andy ...
Juliet Capulet; Tim Goodler; Alex Clark;...
Susane Tyler; Alex Clark; Michael; Rud...
Richard; John; Andy Kort; Robert Rise;...

Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12,2 ¥
>

Completed

Selected: 1 folder(s} in 1 mailbox(es)

After establishing the connection, the export will start. Required time depends on how many items are selected

for export. You will be shown a progress window during the export. The window shows the number of saved
folders, messages, errors and total expected items to be restored. You can disable the progress window
directly in the window or go to the Options menu and select Show progress dialog.
The export can be cancelled by clicking the Cancel exporting button on the taskbar.
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X

Axcient

DirectRestore

- oI

1EE &

[¥]C3 Drafts (0)

-] Brian
-] &) Dalia
t-[ ] HealthMaiboxadeSae Febb54860a 1cf021
+-[_]&§ HealthMailboxbaaB42:26014%a528ha5!

[

[

[

[

[

[

-9 John
-] &9 Juliet Capulet
[E

[

[

[

[

[

[

[E

B4 Q In itsnature, it is arbitrary an... Kyle Pakerman

Progress

Cancel curent operation
Show the dialog next time

Exporting into original Exchange Server mailbox

Andrew Wait; Richard; John; Dalia; Ro...
- " ttague; Richard; Dalia; Mic...

tague; Andy Kort; Robert ...

ar; Andy Kort; Juliet Capulet...
Tim Goodler; Kyle Pakem...
*akeman; Michael; Susan...
sel; Richard; Dalia; Luise; T...

ls; Brian; Juliet Capulet; Ro...
: Maria Woods; Andrew W...
:r; Maria Woods; Romeo M...
Capulet; Andy Kort; Robert...

Yy Axcient DirectRestore
File  Options Help
Search in Alex Clark p
Browse
=-[8] ) Maibox Database edb ~ Type Subject From To Created L
B4 She was glad that Jo shoul...  Luise Maria Woods; Kyle Pakeman; Luise; ...  Wednesday, March 12, 2

Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2

Folders o Zlark; Richard; Romeo Mon... Wednesday, March 12, 2

----- VI3 Sert tems (0) Messages 6 Woods; Richard; Alex Clar... Wednesday, March 12, 2

----- | Tasks (48] Em= 0 lohn; Tim Goodler; Michael... Wednesday, March 12, 2
-] £ Andrew Wait Total messages count 1.669 ttague; Richard; Andrew W... Wednesday, March 12, 2
i-[_]£9 Andy Kort Elapsed time 00:00:05 ttague; Richard; Juliet Cap... Wednesday, March 12, 2

Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2

B4 Mow, herald, are the dead ... Alex Clark Michael; Alex Clark; Susane Tyler; Ro...  Wednesday, March 12, 2

]Dd Kyle Pakeman B4 Dieu vous garde, monsieur.... Michael Maria Woods; Robert Rise Wednesday, March 12, 2

3"D|ﬂ Luise B4 I you had seen the look in ... Romeo Montague  Dalia; Juliet Capulet; Alex Clark; Rome... Wednesday, March 12, 2

5[] &9 Maria Woods B4 She wore a gray blouse wit... Robert Rise Alex Clark; Susane Tyler; Maria Woods... Wednesday, March 12, 2

-] 9 Michael B4 But though the public scho...  Luise John; Brian; Michael; Andy Kort; Maria ... Wednesday, March 12, 2

3"D|ﬂ Personal Archive - HealthMailboxade9ae Fe B4 if twas in gold; but at the sa... Andrew Wait Rudy Raid; Juliet Capulet; Brian; Andy ... Wednesday, March 12, 2

]--Dd Personal Archive - HealthMailboxbaaB042e =] My stars shine darkly over ...  Rudy Raid Juliet Capulet; Tim Goodler; Alex Clarc;... Wednesday, March 12, 2

JDﬂ Richard B4 Charey was of these peopl... Romeo Montague Susane Tyler; Alex Clark; Michael; Rud... Wednesday, March 12, 2
1-[_] = Robert Riss b B4 Richard Richard; John; Andy Kort; Robert Rise;... Wednesday, March 12,2 ¥

£ > £ >

Exporting into original Exchange Server mailbox (folders: O... 00:00:05 Selected: 1 mailbox(es)

5.3.2 Restore to live Exchange Server. Expert mode
Axcient DirectRestore includes the injection capability for items (emails, calendars, contacts,

database and PST and OST files to live Exchange database.

The following options are presented:
¢ Authentication

etc.) from offline

e Connection to a mailbox using its owner credentials. To provide the connection, host (domain name or IP),
user logon name and password are required. It is also possible to connect through current Windows

credentials.

o Connection to another account mailbox by using Exchange impersonation. (http://msdn.microsoft.com/en-
us/library/bb204095%28EXCHG.140%29.aspx).
e Connecting to several mailboxes on different servers simultaneously.

¢ Browsing folder hierarchy of a connected mailbox, browsing folder contents and viewing message bodies and
other items (calendars, contacts).

¢ Creating folders in the connected mailbox.

¢ Drag-and-drop copying of folders and individual items from offline (source, EDB) database, PST or OST file to

the attached mailbox (destination live Exchange server).
e To provide injection, running the application as administrator or using a machine from AD domain, in which
there is Exchange Senrver with destination mailbox, is not required.
¢ Injection is possible to a local machine, as well as machines with Exchange Server, which are in the local

network or the Internet.
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Connection to Exchange Server
After opening a mail store the main window of the application looks as follows:

File  Options Help

Search in Alex Clark P -

Browse Destination
=143 Maibox Database.edb g Subject From To

a9 f\lexcfallarkd aam She was glad that Jo shoul...  Luise Maria Woods: Kyl
L] Calendar o § Initsnature, itis arbitrary an... Kyle Pakemman Andrew Wait; Ric Connect to a live server to enable
It is my lady mother. #is my... Juliet Capulet Fomeo Montague S2potcichiccs v S =ce
Butthat it might not appeart... John Fomeo Montague
Do you persuade yourself ... Andy Kort Susane Tyler; An
| regret that | am unabletor... Brian John; Brian; Tim (
Alas, the heavy basketwhic... Alex Clark Dalia; Kyle Paken
He went up @ dark and narr... Rudy Raid Brian; Michael; Ri
Moone, even there, could li... Romeo Montague — Brian; Alex Clark;
One of the things particular... Robert Rise John; Maria Woor
Stephen Brice read the ne...  Luise Alex Clark; John;
Give me some light! Give m... Michael Fomeo Montague
His condition leaves him no... Juliet Capulet Fomeo Montague
What a pied ninmy's this! ... Maria Woods Maria Woods; Bri
Your vows, your memories, ... John Robert Rise; Mari
The riders could be heard ...  Andrew Wait Susane Tyler; Ma
The sinewand heart of man... Susane Tyler Brian; Juliet Capu
Now, herald, are the dead ... Alex Clark Michael; Alex Clai
Dieu vous garde, monsieur.... Michael Maria Woods; Ro
If you had seen the look in ... Romeo Montague  Dalia; Juliet Capu
She wore a gray blouse wit... Robert Rise Alex Clark; Susan
But though the public scho... Luise John; Brian; Mich
if twas in gold; but at the sa... Andrew Wait Rudy Raid; Juliet
My stars shine darkly over ...  Rudy Raid Juliet Capulet; Tin
Charley was of these peopl... Romeo Montague — Susane Tyler; Ale
Richard Richard; John; Ar ¥
>

>

~OO0000O0000oOoOO0oOoOooOoOdoooodo o

Mo live servers connected.

1AM
(40)

-] Andrew Wait
-] 55 Andy Kot
-] &9 Brian
-] Dalia
[-[_]£9 HealthMailboxadsSas Fe5b54860a1cf0218
[-[_]£9 HealthMailboxbaa8042226014%2928ba55
-] John

[-[ ]9 Juliet Capulet
£

[

£

£

£

£

£

£

[ttt don [ttt Y o Y o Y [t iy =

H-[ ] =9 Kyle Pakeman

jD@ Luise

H-[_] =9 Maria Woods

1[5 Michael

H-[_] =) Personal Archive - HealthMailboxadeSae e
H-[_] =) Personal Archive - HealthMailboxbaa8042s:
1[5 Richard

-] = Robert Fise

&&&&&&&&&&&&&&&&&&&&&&&&&&5;

£

<

v

Completed

There is a panel with a wide splitter added on the right. Toolbar buttons are added to connect to Exchange
Sener and inject checked items to the attached mailbox.

The injection button (next to the Export selected data into PST button) becomes active when there is a
connection with at least one live mailbox and items in the offline database are checked.

The button for the connection to the mailbox has a drop-down list with mailboxes, which were attached
previously. When clicking Select menu item for the attached mailbox in the drop-down list, it appears in the
tree on the right and becomes selected. It is also possible to disconnect from the mailbox by clicking the
Disconnect menu item.

kD

Attach to live Exchange mailbox..  Ctrl+T

Create a new Exchange mailbox... Ctrl+W

Recent 3
Brian@no-such-email.com »

| John@no-such-email.com » Select
Dalia@no-such-email.com 3 Disconnect
Alex.Clark@no-such-email.com 3 Refresh

Disconnect all

Clicking the connection toolbar button will bring up the following dialog for entering the credentials:
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Host {ex.: contoso .com ar 192.168.0.5):
| ES2013 nosuch-email com

u ment Wind sl T Ex{:h_anue impersonation lets you connect to

[] Use cu neews = a mailbox other than the default one for your
credentials. To use the feature, access

Uzer logon name (ex.: user1): permissions need to be configured at

|ﬁ..|ex Clark Exchange Server.
[] Connect to a different mailbox

Passward:

|

[] Save password

Fill the following required fields:

* Host: domain name of the machine with Exchange Server, or IP address

» User logon name — user name to log on

» Password - user's password

There is an option of connecting using current Windows credentials. When the checkbox is selected, the User
and Password fields are disabled:

Host (ex.: contoso.com or 1592.168.0.5):
| E52013 nosuch-email com

- Exchange impersonation lets you connect to
| L ment Wind credential -
se e neows s a mailbox ather than the default one for your

credentials. To use the feature, access
User logon name {ex.: user1): permissions need to be configured at
Exchange Server.

[] Connect to a different mailbox

Save password

It is possible to connect to someone else’s mailbox using Exchange impersonation. To do this, check the
Connect to a different mailbox box and enter the mailbox owner SMTP address:
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Host {ex.: contoso .com ar 192.168.0.5):
|E52'|]1 3 no-such-email.com

Exchange impersonation lets you connect to
a mailbox other than the default one for your
credentials. To use the feature, access

User logon name (ex.: userl): permissions need to be configured at

|NE:X Clark Exchange Server.
Connect to a different mailboo

Password: Mailbox owner SMTP address
| (e userl@contoso.com):

[] Use cument Windows credentials

|dE||iE| Enosuch-email com

[] Save password

File | Options Help

Open file...

Recent et mailboxes or folders to search

Close file

Reload database using transaction logs

New connection ( Attach to live Exchange mailbox...  Ctrl+T No live servers connected.

Search for files to open... cate a new Connect to a live server to enable
& o0d MB export of objects from source storage.

. - . te: 3/13/2014
Export into original Exchange mailbox...  Ctrl+G rsion: Exchange Server 2013
Export into live server... Ctrl+E

Export selected itemns into PST... Ctrl+S

Cancel current operation Ctrl+M ansaction leJS not used.
Open log folder mailboxes. Select a mailbox to display folders.

Delete saved temp files and logs ad time: 00:00:04

play time: Local
PST encoding: Unicode (Microsoft Outlook 2003, 2007, 2010 and
2013)
Show deleted items: Only non-deleted items
Incomplete messages: Hide

(]9 Romeo Mantagus Search within attachments: Off

[]&9 Rudy Raid
(-] £9 Susane Tyler
159 SystemMaibox{ade9ae F-=5b5-4860-a 1cf-021
-] &9 Tim Goodler

< File info

Completed
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Injection workflow

After the connection is established, the mail store tree appears on the Destination tab (1). It will be listed in

the drop-down list of the toolbar (2)

connection button and in the File menu (3).

Select mailboxes or folders to search

[[]£9 HealthMailboxadeSae Fe5b54860a 1cf0218267
Dﬁ HealthMailboxbaa 8042226014%aa928ba554e(
&9 John

[]59 Juliet Capulet
[1£9 Kyle Pakeman
159 Luise

159 Maria Woods
[1£9 Michael
[[]£§ Personal Archive - HealthMailboxade 9ae FeSb
]9 Personal Archive - HealthMailboxbaz 80426 260
[ Richard
[]£9 Robert Rise
[]£) Romeo Montague
- ]&9 Rudy Raid
[]£9 Susane Tyler
19 SystemMailbox{adeSae F-25b5-4860-a 1cf-021

]9 Tim Goodler

£

Mailbox Database.edb

C:\Exchange Server Database\Mailbox Database.edb
Size: 904 Mb

Date: 3/13/2014

Version: Exchange Server 2013

Transaction logs not used.

22 mailboxes. Select a mailbox to display folders.
Load time: 00:00:04

Display time: Local

PST encoding: Unicode (Microsoft Outlook 2003, 2007, 2010 and
2013)

Show deleted items: Only non-deleted items

Incomplete messages: Hide

Search within attachments: Off

File info |

9--@ ES2013 no-such-email.com
B.‘ﬁ Alex Clark @no-such-email col

-] Calendar (438)
----- ] Cortacts (45)
[ Deleted ltems (25)
..£3 Drafts (0)
-3 Inbox (1,046)

j Joumal (27)
-3 Junk Email (0)
g MNotes (40)
.7 Outbose (0)
-3 Sent tems (0)

| Tasks (78)

Completed

It is possible to select whether to show folder items and preview or not — a button near the Destination tab is
used for this purpose. If it is disabled there will be only a tree displayed in the right panel.

File  Options Help

L}H &

Browse

Select mailboxes or folders to search

[ERMIY ] Mailbox Database edb

= Alex Clark

[]&59 Andrew Wait
]9 Andy Kot
[1£9 Brian
[ Dalia
[[]£9 HealthMailboxadeSae Fe5b54860a 1cf0218267
[[1£9 HealthMaiboxbaa842e 26014%aa928ba554e(
&9 John
[]59 Juliet Capulet
[]£9 Kyle Pakeman
[E59 Luise
159 Maria Woods
] Michael

Dﬁ Personal Archive - HealthMailboxade Jae Febh

]9 Personal Archive - HealthMailboxbaz 80426 260
-] &9 Richard
[]£9 Robert Riss

[]£) Romeo Montague

]9 Rudy Raid

Dﬁ Susane Tyler

19 SystemMailbox{adeSae F-25b5-4860-a 1cf-021
-] &9 Tim Goodler

£

Mailbox Database.edb

C:\Exchange Server Database\Mailbox Database.edb
Size: 904 Mb

Date: 3/13/2014

Version: Exchange Server 2013

Transaction logs not used.

22 mailboxes. Select a mailbox to display folders.
Load time: 00:00:04

Display time: Local

PST encoding: Unicode (Microsoft Outlook 2003, 2007, 2010 and
2013)

Show deleted items: Only non-deleted items

Incomplete messages: Hide

Search within attachments: Off

File info |

9--@ ES2013 no-such-email.com
Bﬁ Alex Clark@no-such-email.com

-] Calendar (438)
----- ] Cortacts (45)
.. Deleted lems (25)
..£3 Drafts (0)
-3 Inbox (1,046)

A Joumal (27
-3 Junk Email (0)
g MNotes (40)
-3 Outbox (0)
-3 Sent tems (0)

| Tasks (78)

Completed

After enabling the button a list with the items is displayed as well as a preview when clicking on the item.
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File

=

Options  Help

Select mailboxes or folders to search

Egw «
=t

gl

Browse

£

=] '} Mailbox Database.edb
129 Alex Clark

Dﬁ Andrew Wait
159 Andy Kor

[J£9 HealthMaiboxade Jae Fe5b54860a1cf 0218267
[J£9 HealthMaiboxbaaB042e260149aa528ba554s(
[]&9 John

]9 Juliet Capulet

[ ]9 Kyle Pakeman

&9 Luise

[]£9 Maria Woods

&9 Michael

Dﬁ Personal Archive - HealthMailboxade ae #e5b

[]£9 Personal Archive - HealthMailboxbaz 80422260

]9 Richard

]9 Robert Risz

[]£9 Romeo Montague

159 Rudy Raid

[J£9 Susane Tyler

Dﬁ SystemMailbox{ade 9ae F-e5b5-4860-a 1cf-021
-] &9 Tim Goodler

Mailbox
Database.edb

C:\Exchange Server
Database\Mailbox
Database.edb

Size: 904 Mb

Date: 3/13/2014
Version: Exchange
Server 2013

Transaction logs not
used.

22 mailboxes. Select a
mailbox to display
folders.

Load time: 00:00:04

Display time: Local

PST encoding: Unicode
(Microsoft Outlook

2003, 2007, 2010 and
2013)

Show deleted items:

Only non-deleted |tems v

Trromn
File info

[

9--@ ES2013.no-such-email.com

£ Alex Clark @no-such-email com

-] Calendar (428)
----- Aa] Contacts (45)
{3 Deleted tems (25)
..£3 Drafts (0)

B oo (1045 |
j Joumal (27)
- Junk Email (0)

g Motes (40)

{3 Qutbox (0)

{3 Sent ttems (0)
o] Tasks (78)

Type g Subject
She was glad that Jo should defend M
ﬂ In itsnature, it is arbitrary and discretior
It is my lady mother. | is my lady mothe
Butthat it might not appearto preclude
n Do you persuade yourseff that | resped
| regret that | am unable to rememberth
ﬂ Alas, the heavy basketwhich the Color
ﬂ He went up a dark and namow stair int
Moone, even there, could live on poeti
g Cne of the things particulatyadmirable
>

. [Z..[L[L[L[L EEEE

Do you persuade yourselfthatl... X
v

5 attachm »

From: Andy Kort

Sent  Wednesday, March 12...
To: Susane Tyler; Andy Kort...

| pray you be acquainted with this
maid;
She comes to do you good.
ISABELLA. | do desire the like.
DUKE. Do you persuade yourseff that |
respect you?
MARIANA. Good friar, | know you do,
and have found it.
DUKE. Take, then, this your companion <€

Preview | Properfies

Completed

File

Options  Help

Search in Alex Clark

E||:| v Maibox Database.edb O
B[ ]9 Alex Clark 0=

From To
Luise Maria Woods; Kyle Pak:

] Subject

She was glad that Jo shoul.. Egue@ﬂoﬁuch-e

£

[z Calendar (438)

[ 22 Cortacts (45)

I Deleted fems (25)

13 Drafts (0)

B(EY Inbox (1.046) |

1.8 Joumal 27)

[ dunk Email (0)

[ Motes (40}

[ Outbox (0)

[ Sert tems (0)

13 Tasks (42)

H-[ ] 59 Andrew Wait

-] Andy Kot

H-[_] 59 Brian

1] Dalia

) Dﬁ HealthMailboxade9as #ebb54860a1cf0218
H-[_] =) HealthMailboxbaaB042e260145aa928ba55
1] John

jDﬁ Juliet Capulet

H-[ ] =9 Kyle Pakeman

H-[ ] Luise

H-[_] =9 Maria Woods

-] 59 Michael

H-[_] =) Personal Archive - HealthMailboxadeSae e
H-[_] =) Personal Archive - HealthMailboxbaa8042s:
-] & Richard

E
£
E
E
£
E
E
£
E
E
£
E
E
E
£
£

-] = Robert Fise

=N
Dtﬂ
Dtﬂ
=N
Dtﬂ

Do you persuade yourseff t..

What a pied ninny’s this!

NN EHEE
[t domn Y o Y [4mm Yoo T} [i~=T1i~

o
[

In itsnature, it is arbitrary an...
It is my lady mother. 1 is my...
Butthat it might not appeart...

| regret that | am unable tor...
Alas, the heavy basketwhic...
He went up a dark and narr...
Noone, even there, could |i...
One of the things particular...
Stephen Brice read the ne....

Give me some light! Give m...
His condition leaves him no...
. Maria Woods
*Your vows, your memories, ...
The riders could be heard |..

The sinewand heart of man...
Now, herald, are the dead ..

Dieu vous garde, monsiewr. ...
If you had seen the look in ...
She wore a gray blouse wit...
But though the public schao...
if itwas in gold; but at the sa...
My stars shine darkly over ...

ﬂ Charley was of these peopl...

Kyle Pakerman
Juliet Capulet
John

Andy Kort
Brian

Alex Clark
Rudy Raid
Romeo Montague
Robert Rise
Luise

Michael

Juliet Capulet

John

Andrew Wait
Susane Tyler
Alex Clark
Michael

Romeo Montague
Robert Rise

Luise

Andrew Wait
Rudy Raid
Romeo Montague
Richard

Andrew Wait; Richard: .
Romeo Montague; Rich
Romeo Montague; Andy
Susane Tyler; Andy Kort
John; Brian; Tim Goodle
Dalia; Kyle Pakeman; b
Brian; Michael; Richard;
Brian; Alex Clark; Richar
John; Maria Woods; Ric
Alex Clark; John; Tim Ge
Romeo Montague; Rich
Romeo Montague; Rich
Maria Woods: Brian; Jul
Robert Rise: Maria Woo
Susane Tyler; Maria Wo
Brian; Juliet Capulet; An
Michael; Alex Clark; Sus
Maria Woods; Robert Fi
Dalia; Juliet Capulet; Ale
Alex Clark; Susane Tylel
John; Brian; Michael; Ar
Rudy Raid; Juliet Capule
Juliet Capulet; Tim Gooc
Susane Tyler; Alex Clark
Richard: John; Andy Ko ¥
>

'EEE Calendar (429)

-Aa] Cortacts (44)
.53 Deleted hems (15)
..£3 Drafts (0)

-3 Inbox (1,047)

A Joumal (25)
-3 Junk Email (0)
- Motes (35)

-3 Outbox (0)
Sent Items (1]

Su; Calendar |43E}
----- Aa] Contacts (45)
3 Deleted eme (25)
..£3 Drafts (0)
-3 Inbox (1,046)
j Joumal (27)
-3 Junk Email (0)
g MNotes (40)
-3 Outbox (0)
-3 Sent tems (0)
| Tasks (78)

= ES2013. noauch-emall com

Completed

After mailbox appears in the tree, it is possible to drag-and-drop folders and separate items. When dragging a

folder or a mailbox to live Exchange mailbox, the hierarchy of the data being dragged will be recreated inside
the destination folder.
When right-clicking folders/mailboxes in the destination panel, it is possible to create a folder inside the
mailbox.
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File  Options Help

] i | X = L
7 H "%_:4 Search in Alex Clark |p| E

Browse b}
=-[m] gy Mailbox Database edb M f Subject -5 ES2013no-such-email.com | Subject

B--E%%&x&;ﬁdar - 0= She was glad that Jo Bﬁ Alex Clark @no-such-email.con g

[ 2] Cortacts (45)

Hia g e e G 121 Calendar (438) In itsnature, it is arbitrary and discretion...
n In itsnature, it is arbitr .

' -Aa] Contacts (45
= It is my lady mother. g Deleted hém: 25) It is my lady mother. | is my lady mothe...
O= Butthat it might not af .03 Drafts (0} : Do you persuade yourself that | respec...
= ﬁ Do you persuade you £ Inbax (1,045) | regret that | am unable to rememberth. ..
= | regret that | am unal &l Joumal (27) It wasall eloquence, and generous and...
= Mlas, the heavy bask 73 Junk Email {0} Mlas, the heavy basketwhich the Colon...
He went up a dark ar .y MNotes (40) He went up a dark and namow stair int....
Moone, even there, ¢ {3 Qutbox (0) Moone, even there, could live on poetr. ..
One of the things par {3 Sent kems (0) One of the things particuladyadmirable i...
Stephen Brice read th What mean you, sir? What mean you, ...
Give me some light! C Bn‘ﬁ Dalia@noﬁucﬁ-email_com Prince. Prince. Prince. Prince. Princ...
His condition leaves | -] Calendar |:4DE} Give me some light! Give me some light!
What a pied ninny'st | ||| | @ i L] Contacts (44) ) What a pied ninny’s this!
Your vows, your mem -3 De'e‘e‘? tems (23) The riders could be heard loud-voiced ...
The riders could be h g Drafts (0) Now, herald, are the dead numb'red? ...
The sinewand heart « . New folder N | £3 Mail and Post mero...
Now, herald, are the .3 Junk EmaTTOT )
Dieu vous garde, moi i Notes (40) . o B4 Calendar .
I you had seen the Ic .3 Outbox (0} 4] Contact
L
4

[ Outbex (0)

[t Sent tems (0)

13 Tasks 49)

-] 59 Andrew Wit
-] Andy Kort
-] &9 Brian
&[5 Dalia

[-[ ]9 HealthMaiboxadeJae Fe5b54860a1cf0218
(-] 59 HealthMailboxbaa8042=26014%2928ba55
-] &9 John

[-[ ]9 Juliet Capulet
- ]9 Kyle Pakeman
[

[

[

[

[

[

3

[ttt Y o Y [ Yoy oY o Y [4mmt iy

IIENIE NN EEMEE

H-[ ] Luise
H-[_] =9 Maria Woods

@

She wore a gray blou .. Sent tems (D) Note
]Dﬁ Michael But though the public Z Tasks (47) T
H-[_] =) Personal Archive - HealthMailboxadeSae e if itwas in gold; but at 2
H-[_] =) Personal Archive - HealthMailboxbaa8042s: My stars shine darkly A Journal of ...
[ ]£59 Richard ] Charey was of these
]D,@ Robert Rise in atown of war, et wild, the people's
£ > >

Ooooooooodbooro”Og

Completed Selected: 4 item(s) in 1 mailbox(es)

It is also possible to delete and rename created folder within one program session. When checking the items
in the offline database, data exporting is available by clicking the Export into live Exchange Server mailbox
button. This method is the equivalent of saving to PST, except that the target is a live sener, not a file. It is
complementary to drag-and-drop and useful for management of disparate data. With this method, items of
different types (e.g. notes and tasks) and/or located in different offline database folders/mailboxes or in different
PST/OST files can be exported.

File  Options Help

/ '.-';, I:lﬁﬂ Search in Alex Clark | p | v.

Browse D
=-[]4) Maibox Database edb | Subject 9% ES2013.no-such-email.com Type ] Sublect
=[] &) Alex Clark = Aex Clark @no-such-email com
B o § e 2 S e, oy o dcrtor
[ &<] Contacts (45) _ ' & Contacts (45) : ' 1y and discrefior
[ Deleted tems (25) It is my lady mec 3 Deleted iems (25) It is my lady mother. | is my lady mothe
[ Drafts (0) Butthat it mighi .. Drafts (0) Butthat it might not appearto preclude
CEa Do you persua -3 Do you persuade yourself that | respec
.8 Joumal (27) | regret that | a Al Joumal (27) | regret that | am unable to remembertt
&3 Junk Email (0) Alas, the heav -3 Junk Email (0) Alas, the heavy basketwhich the Color
[Ji. Notes (40) He went upa g Notes (40) He went up a dark and namow stair int
[E3 Outbox (0} Moone, event {3 Qutbox (0) Moone, even there, could live on poeti
[(IE3 Sent ttems (0) One of the thir -3 Sent tems (0} One of the things particulatyadmirable
DZ Tasks (48} Stephen Brice Stephen Brice read the news in the blz
]Dﬁ Andrew Wait Give me some Bn‘ﬁ Dalia@no-such-email. com Give me some light! Give me some ligh
-] 59 Andy Kot His condition l¢ -] Calendar (406) His condition leaves him na time to rec
]Dﬁ Brian What a piedni | || | L] Contacts (44) What a pied ninny’s this!
Your vows, your memories, and your h

1] Dalia -7 Deleted tems (23)
H-[_] =) HealthMailboxade 9ae FeSb54860a1cf0218 .3 Drafts (0) The riders could be heard Joud-voiced
The sinewand heart of man seem to be

[

[

[

[

[

[ Dﬁ HealthMailboxbaa 8042 260145%aa928ba55 .23 Inbox {1,000}

-5 John A Joumal (27)

= Dg Juliet Capulet ‘ .3 Jurk Email (0) N.ow. herald, are the de.ad nun'.lb'red?.
[ Dﬁ Kyle Pakeman Dieu vous gart . Notes (40) Dieu vous garde, monsieur. Dieu vous
[ I you had seen the look in hiseyes, yo
B She wore a gray blouse with ared scar
[
[
[
[
3

Your vows, yo!
The riders cou
The sinewand
Now, herald, a

[ Y Y o [T} =

0[] Luise tf you had seei .3 Outbex (1)

5[] 5 Maria Woods She wore a gr .. Sent tems (D)
But though the public schools and univ
if twas in gold; but at the same time de

1] =9 Michael But though the 2] Tasks (47)

H-[_] =) Personal Archive - HealthMailboxadeSae e if twas in gold;
My stars shine darkly over me;the m
Charley was of these people-from the

]Dﬁ Personal Archive - HealthMailboxbaa 8042, My stars shine
Charley was of
v
>

0[] Richard
-] = Rober Fise

[Z..[L[L[L[L[LK.&&[L&[L[L[L[L[L[L&&[L&[L&[L[L[L5;

o o

"IN ENENNECNEEEEEEEEE

£ >

Completed
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When clicking the Export into live Exchange Server mailbox button, a dialog, which allows to select a
folder to save selected data, appears. Data hierarchy will be restored automatically. The root of hierarchy is the
closest common parent item.

== ES2013no-such-email.com
- Alex Clark @no-such-email.com

114 Calendar (438}
..... 2. Contacts (45)
T3 Deleted tems (25)
£ Drafts (0)
3 Inbox (1,048)

A Joumal (27)
{7 Junk Email (0)
iy Motes (40)
3 Outbax (0)
--[CJ Sent ttems (0)

| Tasks (78)
- Dalia@no-such-email.com
-1 Calendar (406)
..... A Contacts (44)
--[CJ Deleted tems (23)
£ Drafts (0)
B oo (o)

A Joumal (27)
{7 Junk Email (0)
iy Motes (40)
.3 Outbox (0)
--[CJ Sent ttems (0)

| Tasks (47)

[ ] Unselect successfully exported tems
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Create a new Exchange mailbox

Creating via main menu:

File | Options

Help

Open file...
Recent
Close file

Reload database using transaction logs

Ctrl+ O

et mailboxes or folders to search

P

MNew connection

Attach to live Exchange mailbox..  Ctrl+T

Search for files to open...

Export selected itemns into PST...
Export into original Exchange mailbox...
Export into live server...

Cancel current operation

Open log folder

Delete saved temp files and logs

Archive - HealthMailboxbaa

Dﬁ Romeo Montague
159 Rudy Raid
[J£9 Susane Tyler

-] &9 Tim Goodler

£

Ctrl+S
Ctrl+G
Ctrl+E
Ctrl+N

2226

[J£9 SystemMaibox{ade9ae F-e5b5-4860-a1cf-021

Create a new Exchange mailbox...  Ctrl+W

Recent

rsion: Exchange Server 2013
ansaction logs not used.

mailboxes. Select a mailbox to display folders.
ad time: 00:00:05

play time: Local
encoding: Unicode (Microsoft Outlook 2003, 2007, 2010 and
2013)
Show deleted items: Only non-deleted items
Incomplete messages: Hide
Search within attachments: Off

File info

-

&=
Destination
Mo live servers connected.

Connect to a live server to enable
export of objects from source storage.

Completed

Creating toolbar button:

File  Options

=

Help

Select mailboxes or folders to search

K

O @ HealthMailboxade9ae Aebb54860a1cf0218267
O @ HealthMailboxbaa8l42e260145aa928ba504el

[]£9 Michael
Dﬁ Personal Archive - HealthMailboxade See #e5h
Dﬁ Personal Archive - HealthMailboxbhaa 80422260

Mailbox Database.edb

C:\Exchange Server Database\Maibox Database.edb
Size: 904 Mb

Date: 2014-03-13

Version: Exchange Server 2013

Transaction logs not used.

22 mailboxes. Select a mailbox to display folders.
Load time: 00:00:04

Display time: Local
PST encoding: Unicode (Microsoft Outlook 2003, 2007, 2010 and

]

Ctrl+T

Ctrl+W

Attach to live Exchange mailbox...

Create a new Exchange mailbox...

Expol

Recent

al s from source storage.

[159 Richard 2013)
[] &9 Fobert Rise Show deleted items: Only non-deleted items
159 Romeo Montague Incomplete messages: Hide
]9 Rudy Raid Search within attachments: Off
D@ Susane Tyler
D@ SystemMailbox [ade Jae F-=505-4860-a 1cf-021
Dﬁ Tim Goodler
< 5| Fiteinfo |
Completed

Creating via context menu when live Exchange Server is connected (all fields in ‘Server Information’” window will
be filled in automatically based on connected mailbox info’):
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File  Options Help

I!.'_=‘—7 | I & Select mailboxes or folders to search

Mailbox Database.edb

C:\Exchange Server Database\Mailbox Database.edb

) X Size: 904 Mb
Eg en Date: 3/13/2014
5[] 59 HeathMalboxadeSas TieBb54860a Tcf0218257 Version: Exchange Server 2013
(-] £ HealthMailboxbaa 80422 2601452a9280a554e .
-] 59 dohn Transaction logs not used.
[-[ ]9 Juliet Capulet
w155 Kyle Pakeman 22 mailboxes. Select a mailbox to display folders.
&[5 Luise Load time: 00:00:04
-] 59 Maria Woods
-] 59 Michael Display time: Local

[]£9 Personal Archive - HealthMailboxadeSae Fe5b! PST encoding: Unicode (Microsoft Outlook 2003, 2007, 2010 and
Dﬁ Personal Archive - HealthMailboxbaa 80422 260 2013)
-] Richard Show deleted items: Only non-deleted items
&-[]59 Robert Rise Incomplete messages: Hide
-] 5 Romeo Montague search within attachments: Off
-] &9 Rudy Raid
(-] £9 Susane Tyler
-] 59 SystemMaibox{adeSae F-25b5-4860-a 1cf-021
-] &9 Tim Goodler

( File info |

..£3 Drafts (0)
{3 Inbose (0)

----- j Joumal (0)
- Junk Email (0)
iy MNotes (0}
{3 Outboxe (0)
{3 Sent kems (0)
----- E Tasks (0)

[ER==] ES2013 nosugbeanai o
5 Admiristrd Refresh

£ Calen New mailbox
..... Aa] Contz

.3 Delet Disconnect

Completed

of the server. User must have permission to create mailboxes.

Server Information
Erter the server host and account information.

Host {ex.: contoso.com or 152.168.0.5)
| ES2013 nosuch-email com

IUser logon name (e.g.: user1):™

Password:™

Mailbox creation window with new user’s information filled in.

Mailbox creation window with server information filled in. ‘Host’ filed may contain either an IP addess of FQDN
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User information
Enter the user name and account information.

First name (e.g.: john): Initizls: Last name (e.g.: smith):
Jack || | White

Mame (2.g.: john smith):™

Jack Whits

|User logon name (2.4.: john)™ Upn suffec: (e.g.: es2010.com)”
|iEld'i'ﬁh'ftE | |no-sud1-email.com

Password:™ Corfirm passward:™

| <Back |

Mailbox creation window with user’s alias and mailbox database fields. If mailbox database is not specified the
mailbox will be created in the default database.

Mailbox settings
Enter the alias for the mailbox user, and then select the mailbox location.

Alias (e.g.; jsmith):™
| JackWhite

[ ] Specify the mailbox database {=.g.; main_db):*

Mailbox creation window with user’s alias and mailbox database specified. Refresh button is used to refresh
information about available databases in connected sener.
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Mailbox settings

Enter the alias for the mailbox user, and then select the mailbox location.

Alias [e.g.: jsmith).*
JackWhits

Specify the mailbox database (2.9.: main_db):™

File  Options Help

N
. I L |Seart:h in all mailboxes
l/_: 1 -

Browse
[ERMIY ] Mailbox Database edb =-£5] ES2013 no-such-email.com
Mailbox Database.edb =W="] JackWhite @no-such-email coi
-] Calendar (0)
C:\Exchange Server Database\Maibox Databaseedb | | = Aa] Contacts (0}

Size: 904 Mb .27 Deleted ttems (0}
Eg Ea"ihm Iboxadeae e 5b54860a 1cf0218267 Date: 3/13/2014 g P':ﬂs .-Ig}

-] ealthMailboxade Jae e i Inbo |

Dﬁ HealthMailboxbaa 80422 2601452292 8ba554el Version: Exchange Server 2013 A Joumal (1)

-] John . [ Junk Email (0)

-] 59 Julet Capuet Transaction logs not used. o Notes (0

- Kyle: Pak (3 Outbox (0
Eg L:::e FrEman 22 maiboxes. Select a maibox to display folders. g s:mc:erlns} o

]9 Maria Woods Load time: 00:00:03
159 Michael
(159 Personal Archive - HealthMaiboxadeSae Fefb!  Display time: Local

[[] 59 Personal Archive - HealthMailboxbaa8042:260  PST encoding: Unicode (Microsoft Outiook 2003, 2007, 2010 and
[]£9 Richard 2013)

[]5) Robert Rise Show deleted items: Both

[[]£9 Romeo Mortague Incomplete messages: Hide

=9 Rudy Raid Search within attachments: Off

[[]£9 Susane Tyler
Dﬁ SystemMailbox {adeSae F-25b5-4860-a 1cf-021

-[]£9 Tim Goodler

< File info |

Completed

Exchange Server settings for creating a new mailbox

As per Microsoft recommendation Hosting Controller will communicate with Exchange using Remote Power

Shell.

To start using HC with Exchange Server you would have to enable PS Remoting on Exchange CAS senver

using following steps:

1. Run Enable-PSRemoting command in Exchange Management Shell.

2. Enable BASIC authentication on Exchange PowerShell virtual directory in the IIS Manager under Default
Web Site.
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e -H |2z |8 L,;? Authentication

483 £52013 (NO-SUCH-EMAIL\Ad

- Q Application Pools
AE Sites Anonymous Authentication Disabled

Group by: Mo Grouping 5

FY

Mame Status Response Type

4 & Default Web Site ASP.MET Impersonation Dizabled

b aspnet_client  Basic Authentication Enabled HTTP 401 Challenge :
.,? Autodiscover Digest Authentication Disabled HTTP 401 Challenge

¥ ecp Forms Authentication Disabled HTTP 302 Login,/Redirect

LEl}

¥ EWS Windows Authentication Disabled HTTP 401 Challenge

LEl}

¥ Microsoft-Server-£

LEl}

¥ OAB

LEl}

H? owa

i "3 PowerShell

L El}

LEl}

[ ,@ Exchange Back End

3. Make sure that the user whose credentials you are using has “Remote PowerShell” enabled
a. get-user USERNAME |fl RemotePowerShellEnabled

Note: replace USERNAME with actual user name, e.g. ‘Administrator’

If the command above shows RemotePowerShellEnabled as False please execute the following command.
b. set-user USERNAME -RemotePowerShellEnabled $True

5.3.3 Working with clustered Exchange Server configuration

Exporting data into live instance of clustered Exchange Server does not differ from working with any other
server configuration. Even if there are several servers with Mailbox Server roles in your configuration, and they
have been added to your CCR/DAG, data can be easily restored.

Client Access < Active Directory
Server Domain Controller
I~ O e e |
| : v
|
CCR/DAG
sl : —— Client PC with
| Restore Tool
| ! =
I Mailbox |
L _Serverl  Server2 _  Serv I P
[
»
Axcient Appliance
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As you can see on the scheme, to export data into live server, Axcient DirectRestore calls Client Access
Sener to get access to specified mailbox. And it doesn't really matter which of existing Mailbox Servers stores
target mailbox - data will be exported to the right place.
The IP-address or FQDN of Client Access Server should be specified in the Host field while using the Expert
mode. In the Export into original mode FQDN of this server is detected automatically by calling Active

Directory domain controller.

5.3.4 Restore to PST files

To sawe items marked for export, click the Export selected items button on the toolbar or select the point in

the File menu.

DX

Axcient DirectRestore

- )

File  Options Help

-
"jf o Search in Alex Clark p
Browse
E‘E‘t; Mailbox Database edb ~ Type ] Subject From Ta Created ~
E‘"E“:’ﬂacard(d e B4 She was glad that Jo shoul...  Luise Maria Woods; Kyle Pakeman; Luise; ... 'Wednesday, March 12, 2
Ei"‘l C::tl;c: _v B4 Q In itsnature, it is arbitrary an... Kyle Pakerman Andrew Wait; Richard; John; Dalia; Ro... Wednesday, March 12, 2
_____ [ Deleted Item; 25) B4 It is my lady mother. #is my... Juliet Capulet Romeo Montague; Richard; Dalia; Mic... Wednesday, March 12, 2
_____ [l Drafts (0) B4 Butthat it might not appeart... John Romeo Montague; Andy Kort; Robert ... Wednesday, March 12, 2
WIca B4 Q Do you persuade yourself ... Andy Kort Susane Tyler; Andy Kort; Juliet Capulet... Wednesday, March 12, 2
..... 1.4 Joumal B4 | regret that | am unable to ... Brian John; Brian; Tim Goodler; Kyle Pakem... Wednesday, March 12, 2
B4 Q Alas, the heavy basketwhic... Alex Clark Dalia; Kyle Pakeman; Michael; Susan... Wednesday, March 12, 2
B4 Q He went up a dark and narr... Rudy Raid Brian; Michael; Richard; Dalia; Luise; T... Wednesday, March 12, 2
B4 MNoone, eventhere, could li... Romeo Montague  Brian; Alex Clark; Richard; Romeo Mon... Wednesday, March 12, 2
B4 Q One of the things particular... Robert Rise John; Maria Woods; Richard; Alex Clar... Wednesday, March 12, 2
1 B4 Q Stephen Brice read the ne...  Luise Alex Clark; John; Tim Goodler; Michael... Wednesday, March 12, 2
-5 Andrew Wait B4 Q Give me some light! Give m... Michael Romeo Montague; Richard; Andrew W... Wednesday, March 12, 2
(-] 59 Andy Kort B4 g His condition leaves him no... Juliet Capulet Romeo Montague; Richard; Juliet Cap... Wednesday, March 12, 2
&-[_]&9 Brian | What a pied ninny's this! ... Maria Woods Maria Woods; Brian; Julist Capulet; Ro... Wednesday, March 12, 2
] DC’ Dalia ) B4 Q Your vows, your memories, ... John Robert Rise; Maria Woods; Andrew W... Wednesday, March 12, 2
=03 HealthMaflbmdeﬁaeﬁeSbEdEEDmdDNE B4 g The riders could be heard ...  Andrew Wait Susane Tyler; Maria Woods; Romeo M... Wednesday, March 12, 2
e D‘:’ :lehalthMallbmd:aaﬂDdEeZEDMSaaEZBbaSS B4 Q The sinewand heart of man... Susane Tyler Brian; Juliet Capulet; Andy Kort; Robert... Wednesday, March 12, 2
g Ej lei:t Capulet B4 Mow, herald, are the dead ... Alex Clark Michael; Alex Clark; Susane Tyler; Ro...  Wednesday, March 12, 2
& D:’ Kyle Pakeman B4 Dieu vous garde, monsieur.... Michael Maria Woods; Robert Rise Wednesday, March 12, 2
= D:’ Luise B4 I you had seen the look in ... Romeo Montague  Dalia; Juliet Capulet; Alex Clark; Rome... Wednesday, March 12, 2
B D:’ Maria Woods B4 She wore a gray blouse wit... FRobert Rise Alex Clark; Susane Tyler; Maria Woods... Wednesday, March 12, 2
-[JE&9 Michael =] But though the public scho...  Luise John; Brian; Michael; Andy Kort: Maria ... Wednesday, March 12,2
el D:’ Personal Archive - HealthMailboxade9ae Fe B4 if twas in gold; but at the sa... Andrew Wait Rudy Raid; Juliet Capulet; Brian; Andy ... Wednesday, March 12, 2
& D:’ Personal Archive - HealthMailboxbaal042e; B4 My stars shine darky over ... Rudy Raid Juliet Capulet; Tim Goodler; Alex Clarc;... Wednesday, March 12, 2
] ch Richard =) g Charley was of these peopl... Romeo Montague Susane Tyler; Alex Clark; Michael; Rud... Wednesday, March 12, 2
-[_|£=) Robert Rise b B4 Richard Richard; John; Andy Kort; Robert Rise;... Wednesday, March 12,2 ¥
£ £ >
Completed Selected: 1 folder(s) in 1 mailbox(es)
You will be asked to select or create the destination folder for recovered data:
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Selected data will be saved into pst file(z). To start the export select the destination
folder or create a new one and click OK. The export process will start immediately.

4 || Recovered "
L. CLIENT-PC
, Recovered_session
) Recovered_session?
, Recovered_seszion3
, Recovered_sesziond

, Recovered_session3

| . Recovered_zeszionb |

[ TestComnlete Testnlans

PST encoding: | IUnicode (Micresoft Outleck 2003, 2007, 2010 and 2013)

Make Mew Folder | Ok || Cancel

After selecting folder, the export will start. Required time depends on how many items are selected for export.
You will be shown a progress window during the export. The window shows the number of saved mailboxes,
folders, messages and total expected items to be restored (1). You can disable the progress window directly in
the window or go to the Options menu and select Show progress dialog.

The export can be cancelled by clicking an appropriate link in the progress dialog window (2) or by clicking the
Cancel export button on the taskbar (3).

File  Options Help

Search in all mailboxes

[EREIs J Mailbox Database edb
: 3 Alex Clark
g x:;e:c‘:'tvan C:\Exchange Server Database\Mailbox Database.edb
£ Bian Progress
&3 Dalia
29 HealthMaiboxade Sae Fe5b54860a 1cf021¢
£ HealthMaiboxbaa8042e260149aa328ba5¢ Exporting into PST... 27%
ﬁ John
59 Juliet Capulet
ﬁ Kyle Pakeman
ﬁ Luise
(£ Maria Woods
&5 Michael
9 Personal Archive - HealthMailboxadeSae i 4 d 2013)
9 Personal Archive - HealthMailboxbaa8042¢ Elapsed time
&9 Richard
- foete -
ﬁ Romeo Montague
Rudy Raid = ~
3 e
g SystemMailbox {ade%ae F-=5b5-4860-a1cf4 Show the dialog next time
Tim Goodler

Mailbox Database.edb

( FFileinfo |
Exporting into PST... 27% F Selected: 22 mailbox(es)

Tip
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If you closed the progress window, it can be shown again by clicking on the progress bar on the status
panel.

PST file naming, size and format

Axcient DirectRestore exports each mail store into a separate .pst file named “Recovery NNN - <Mailbox
Name>[ - VVV] . pst”, where NNN is current recovery session identifier, VVV — wvolume number in case the
PST has to be written in more than one volume.

Example:

Recovery 001 - John Doe.pst

Recowvery 001 - John Doe - 001.pst

Recovery 001 - John Doe - 002.pst

Recovery 001 - Mary Smith.pst

With large exports, there can be more than one file on the output. Additional files are created automatically
when the file size limit is hit. The size wlume limit depends on the output file encoding. For ANSI PST files the
limit is 1GB, for Unicode files it is 19GB.

Opening exported items in Outlook
To view and manipulate exported items, use Microsoft Outlook to open the Personal Storage File (.pst) files
exported by Axcient DirectRestore:

1. Start Outlook.

2. Click File and choose Open Outlook Data File.

3. Select exported pst file and click OK.

of| = Outlook Today - Microsoft Outlook

File Home 5end / Receive Folder View

{8 Open Calendar
Open a calendar file in Cutlock (ics, acs)
I
Info
Open {3  Open Outlock Data File
Open an Outlock data file (.pst).
Print
Help 0] Open Outlook Data File “
2 options ﬁ: :(-:‘ - 1 <« Local Disk (C:) » Users » User » My Documents v & Search My Documents el
B9 Exit QOrganize v New folder =~ @ @
3 Videos A Name ‘ Date modified Type Size
5 Recovery 001 - Alex Clark 11-03-2015 11:29 Outlook Data File
1% Computer X ~ X
5 Recovery 001 - Andrew Wait -0 15 11:31 Outlook Data File
G Network 5 Recovery 001 - Andy Kort 11-03-2015 11:34 Outlook Data File
L orl
v £ >
File name: v | Qutlook Data File v
Tools Open Cancel
Note

It is not recommended to mowe .pst files that are open in Outlook. Before moving, right- click the name of
the Outlook Data File (.pst) and click Close .
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Restoring exported items into Exchange Server
ltems extracted from a mail store can be easily restored into a live server:
1. Make sure you have Microsoft Outlook with access to the mailbox you want to restore items into.

2. Open .pst file with exported messages.
3.
4

Open the mailbox you need to import data into.
Select the items and drag-and-drop them back into the original folders. They will be automatically

synchronized with the live Exchange Server database.

File Home Send / Receive Folder View
y [F=% % CleanUp - x ;& 23 Restored Mail 13 [
] ;lﬁn = i |
: v v & Done o
Mew  MNew Delete Forward & B} _ Mave O
E-mail Items~ & 7 Create New - .
Mew Delete Respond Quick Steps Mow
4
_________________________________________________________________________________ Search Inbox [Cirl+E) 2

4 Exchange Mailbox
L] Inbox
[ sent Items
@ Deleted Items

[ Drafts

g Junk E-mail
[=| Outbox [2]
[ Restored Mail
LES) R55 Feeds

L& Search Folders
[ Shortcuts

4 Recovery 001 - Juliet Capulet
@ Deleted Items

[ Conwversation Action Settings

Arrange By: Date

B E B Q

Last Week

Andy Kort Thu /16
subj About the Test Mailbox Store +
Romeo Montague Thu 8/16
The farmer imagines power and I
John Thu 8/16
Whilst the world is thus +
Robert Rise Thu 8/16
POLARITY or action and reaction we meet in I
Kyle Pakerman Thu 8/16

ere is one man of genius who has done much for this phil... +

Tim Goodler Thu 8/16
Men such as they are very naturally seek money or power; an... 4

Mewest on top

re

| Susane Tyler Thu &/16

[ Drafts In self-trust all the virtues i
[ Inbox 1932] -] Susane Tyler Thu 8/16
[ Junk E-Mail But the final value of action like that of books and better th... ¥
L& Search Folders 1 lohn Thu 8/16
[ Orphaned Folders Emerson spent the latter part of his life in lecturing and 3
[d Outbox .~ Alex Clark Thu 8/16
I

6 Command-line interface

F LIMITED RIGHT OF REPLACEMEMT

The command line feature allows you to easily process several databases.

Usage: esr.exe <source> <destination>

Example: esr.exe "c:\Mailbox Database.edb" "c:\results\"
Below is a list of commands with their description that can be used in command line:

e There are several ways to set the source file(s):
Operation

<file mask path>

sets a path to file which contains a
list with files to recover

/list=<path>

sets enumeration of files to recover.
Full path to file must be used

Nist={file1, file2, ..., fileN}

Description

mask to path with files

Example

esr.exe c:\*.edb c :\results\

c:\results\

\results\

e Specify the destination directory for the recovered file(s):

esr.exe /list=d:\files_to_recover.txt

esr.exe /list={d:\1.edb, d:\2.edb} c:
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Operation Description Example

<out dir> path to output directory esr.exe c:\*.edb c :\results\
o Detailing parameters:

Operation Description Example

sets the initial directory for the esr.exe /initdir="c:\EDB

initdir=< >
/initdir=<path Open database dialog Mailboxes\"

shows messages that have been

-notfilterfault
notiteniauftymessages filtered due to their damage

esr.exe -notfilterfaultymessages

esr.exe c:\*.edb ¢ :

i =< > i
Iredirect=<path redirects console output to text file \results\ /redirect="c:\result.txt"

if set - the product will remove all

/cleartem
P temp data on startup

esr.exe /cleartemp

7 Glossary

This glossary lists terms and their synonyms, most commonly used in Axcient DirectRestore help.

AD - Active Directory (AD) is a directory senice implemented by Microsoft for Windows domain networks. An
AD domain controller authenticates and authorizes all users and computers in a Windows domain type
network. For additional information, please visit http://en.wikipedia.org/wiki/Active_Directory.

ANSI PST format - An old PST-file format, used in Outlook 97-2002. ANSI format has a 2 GB limit in file size.
Deleted items - ltems/folders deleted from a mailbox hierarchy.

Destination folder/mailbox - A folder/mailbox, selected for export.

EDB - An Exchange database format, used to store information from users’ mailboxes. Synonyms: Exchange
Server database, dataset.

EWS - Exchange Web Senices. EWS provides the functionality to enable client applications to communicate
with the Exchange server. EWS provides access to much of the same data that is made available through
Microsoft Office Outlook.

Exchange impersonation - Exchange impersonation enables a caller to impersonate a given account so that
the operations can be performed with the rights of the impersonated account, instead of the rights that are
associated with the caller's account. Configuration information is available at http://msdn.microsoft.com/en-
us/library/office/bb204095(v=exchg.140).aspx

Exchange Server - A mail server, calendaring software and contact manager developed by Microsoft.
Export - Copying information from an offline mailbox so it can be stored in a pst file or on the live Exchange
Server.

GMT - Greenwich Mean Time (GMT) is considered as a reference point for time.

Host - Domain name of the machine with Client Access role of Exchange Server, or IP address.

Injection - The process of copying data from offline mailbox to live or original connected mailbox on the senver.
Local time - Local time is calculated by adding or subtracting a number of hours, depending on a time zone,
to UTC.

Live Exchange Server mailbox - Destination Exchange server mailbox, that exists on the sener and is
available for connection. Synonym: attached mailbox.

Mail Store - A type of self-storage whereby customers send items by mail or delivery senice (usually by the
box) to be stored at a central location. Synonyms: mailbox, offline database, Outlook storage, database
storage(depending on the conext).

Original mailbox - A mailbox in live Exchange Server that corresponds to the mailbox in the opened
database.
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OST - An Offline Storage Table (.ost) format. OST is used by Microsoft Exchange Server that enables users to
work with their messages and mail data even when access to the mail server isn't available.

PST - A Personal Storage File (.pst) format, used to store copies of messages, calendar events, and other
items. PST files are readable with Outlook or other compatible email client.

Unicode PST format - A PST-file format used in Outlook 2003, Outlook 2007, Outlook 2010 and Outlook
2013, so older versions of Outlook will not be able to open Unicode formatted PST files. Previous versions of
Outlook were using ANSI format. The main reason for this change was to allow for international character
support and to extend the maximum size of PST files beyond the 2GB limit of the ANSI formatted PST files.
UTC - Coordinated Universal Time (UTC) is the primary time standard by which the world regulates clocks and
time. Usually used with references to time zones.
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